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Issue 4.1.D

What’s New?

The following table describes the sections updated to reflect the new and modified
features on Xedio Manager from Xedio Suite 3.02 and 4.01 (compared to Xedio

Suite 3.01).

In the user manual, the icon ﬁ has been added on left margin to highlight
information on new and updated features.

Click the section number (or the description) in the table to jump directly to the

corresponding section.

Section Description

5.6 Possibility to synchronize the Xedio database with the
IPDirector database.

6.4 Media Importer: Possibility to import media from CANON
Compact Flash drive

6.6.1 A Today tab is automatically added to the Saved Filters.
It corresponds to ‘creation date = today’.

6.6.2 Special Status Display for the Elements: explanation has
been added to give information on special display of the
elements in the elements grid.

6.6.3 Quick Text search can now be applied together with an
advanced filter, with an AND operator.

6.6.3 Filter Fields: The most relevant parameters are listed on
the top of the list.

6.6.3 Search Fields Types: logical operators now replace text.

9.2.3 New General Software Parameters for the Default Proxy
Resolution and for the clipping on add frames.

9.2.5 New Software Parameters Profile for Xedio CleanEdit:
check for missing hi-res files in the edit timeline, new
Devices tab, video standard selection and Make Local
option.

9.2.13 New Software Parameters Profiles for Xedio Cutter.

9.3.4,9.3.7 Modification of the Keyboard Profile Parameters for

forward and reverse play

Vil






Xedio Suite Version 4.1 - User Manual — Xedio Manager Issue 4.1.D
EVS Broadcast Equipment — December 2011

1. Introduction

An installation of Xedio Suite can include a single workstation providing a single
fast and easy editing facility or a range of workstations running the various
applications included in the suite to provide a complete newsroom or sports centre
video production solution.

Each installation of a Xedio Suite requires its own specific configuration and set of
parameters. All the workstations, the users, their associated projects, and the
whole media pool are available to the system. Each of these is referenced within
the Xedio database.

Xedio Manager is the application within the suite that manages the configuration
of the installation and defines the parameters used by the system.

Xedio Manager is designed for system administrators to easily use and set the
system up from the very beginning of the installation to the daily asset and
content management.

Xedio Manager can be installed on all computers connected to the Xedio network.
The only requirement is an ODBC connection to the database; otherwise there are
no specific computer or network requirements necessary to enable use.
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2. User Interface

2.1 OPENING XEDIO MANAGER

To start the Xedio Manager application, click on the Xedio Manager
icon on the desktop.

2.2 OVERVIEW OF THE XEDIO MANAGER
WINDOW

The Xedio Manager graphical interface contains four main areas highglighted in
the screenshot below:




Xedio Suite Version 4.1 - User Manual — Xedio Manager Issue 4.1.D
EVS Broadcast Equipment — December 2011

2.2.1

MENU BAR

TOOLS MENU

The Tools menu gives access to the Media File Cleaner tool. This tool shows the
list of all the media files present on the Xedio media servers but not referenced in
the database (orphan files). From the Media File Cleaner window, it is possible to
delete these orphan files. Refer to section 12 ‘Media File Cleaner’ on page 127 for
more information.

VIEW MENU

The View menu provides the following options:

Menu Item Description

Outlook Bar Displays or hides the Outlook bar.
Logbook Bar Displays or hides the Logbook bar.
Full Screen Hides the Menu bar.

HELP MENU

The Help menu provides the About... option which gives information about the
system, such as version number.

The screenshot below gives an idea of the window overview but it is not a
reference for the required version numbers.

Xedio Manager
Copyright [C] E¥S Broadcast Equipment

Additional information :

Application :

Execute Folder :

Xedio Database DLL :
Xedio Database script :

Timecode Extractor :

Database Server Mame :
Database Name :

DSH Name :

Databasze server curent
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The window gives the following information:

Information Item

Meaning

Application

Version number of Xedio Manager.

Execute Folder

Folder Path where Xedio Manager is installed.

Plugins

List of the installed plug-in. When the user selects a plug
in name from the list, the corresponding version is
displayed next to the field.

Xedio Database
DLL

Version number of the DLL allowing the access to the
Xedio database.

Xedio Database
Script

Version number of the database.

It must be compatible with the CleanEdit Database DLL
version number.

Timecode Extractor

Version number of the application which checks the media
and the timecode inside the media.

Database Server
Name

Name of the server where the database resides.

Database Name

Name of the database in SQL server.

DSN Name Data Source Name, label of the currently used ODBC link.
DBMS Database Management System type and version.
Libraries List of the existing DLL libraries. When the user selects a

library name from the list, the corresponding version is
displayed next to the field.

Database Server
Current Time

Date and time from the Database server.
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2.2.2 THE OUTLOOK BAR

The Outlook bar presents nine tabs. They correspond to the areas managed by
Xedio Manager.

Outlook Bar
Encoders
Lir
b achines
Media

ketadata

Playoutz

Softwares

Toolz

Uszers

When Xedio Manager is started for the first time, only the Media and Users tabs
are shown. You need to create a media server before being able to see all the
tabs. See section 6.2 ‘Media Servers’ on page 34.

The following table briefly describes the various categories:

Subject Purpose

Encoders Manages (create, delete and modify) encoders and sets up
their parameters.

LinX Manages interactions with EVS video servers.

Machines Manages interactions with external devices such as VTR,
archive servers, XFile and EVS servers.

Medias Manages all media and associated storage structure as
referenced in the database.

Metadata Manages the creation of metadata profiles which could be
associated to media.

Playouts Manages the playout servers used by the Xedio Suite.

Softwares Sets up all software parameters and allows the creation of
parameter profiles.

Tools Manages database content and users jobs.
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Subject Purpose

Users Manages users and access rights.

Each category provides access to a series of items. Once a category tab is
selected, its specific items are shown as icons. Select any of these icons to
display its relevant interface in the Work area.

Refer to the different chapters of the present manual for complete information on
each category managed by Xedio Manager.

2.2.3 THE WORK AREA

The Work area is only active when an item is selected in one category from the
Outlook area. Thus, the window displayed in the Work area depends on the
selected item. Parameters are set from this area.

2.2.4 THE LOGBOOK AREA

The Logbook area lists the operations that the user performs in the database and
their status. If a problem occurs, an error message is added in the list. At the
same time, the application saves all this information in a log file.
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3. Encoders

3.1 INTRODUCTION

Encoders are physical devices which allow the digitization of incoming audio/video
feeds into multiple file formats. Most of the models are configured to encode lo-
res or hi-res feed. They can be logically grouped to associate physical encoders
handling the same feed, either in hi-res or in lo-res. So, editing operations can be
quickly performed on lo-res media and then reflected to the corresponding hi-res
media for further news production and playout.

The XEDIO I/O encoder model is able to encode both lo-res and hi-res at the same
time.

Five items are available in the Encoders category. They are detailed in the table
below.

Encoders

Presvigw

Item Description

Physical Manager Defines hardware setup and encoding parameters for
each physical encoder.

Logical Manager Defines the logical encoders, i.e. the combination of
physical encoders to form a single logical encoder. For
example, a hi-res encoder and a lo-res encoder receiving
the same feed can be controlled as one single logical
encoder.

Group Manager Allows to create groups of logical encoders that make
logical channels visible from specific workstations.
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[tem Description

Scheduler Displays blocks corresponding to the scheduled ingest
already planned for encoding.

Preview Displays the current video input when the encoder is
recording media.

3.2 PHYSICAL MANAGER

3.2.1 INTRODUCTION

You must define and configure a physical encoder before you can use it.

When you click the Physical Manager button, the Physical Encoders Manager
window is displayed in the Work area, allowing you to define or update encoding
hardware connected to the network (Encoder type, IP address) and the encoding
parameters.

Contextual menus are available for additional operations.

- 7% CDMHIRES

o BT
=¥ Charinel 1

Encoder Model : C PEG1

- “% CDMLORES | iotion ch *EG1 Encoder

A
<F Channel 1

Juiprmemt

MPEGT

Label : WS Encoder 1

IP Address : .1 o100 . 104

Dezcription :
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3.2.2

Issue 4.1.D

CREATING PHYSICAL ENCODER

To create and configure a physical encoder, complete the following fields and then
click on the Create button.

The encoder name is added to the list on the left side of the window and ‘Channel
1" appears underneath. As the XEDIO I/O model is a multichannel encoder, up to 2
channel numbers are displayed under the encoder name.

Field

Description

Encoder Model

Select an encoder model among CDM[1] (also called
CDM-MPEG), CDM[2], XEDIO I/O (also called CDMJ3]
PCX3)

Encoder Description

Automatically filled at encoder model selection.

Company

Automatically filled at encoder model selection.

Number of Channels

Automatically filled at encoder model selection.

Type Automatically filled at encoder model selection.

Label Name you give to the physical encoder, as it will appear
in the list. Preferably choose a name relevant to the job
of the encoder or to its position in the Xedio architecture.

IP Address IP address of the physical encoder.

Description Optional text to describe the encoder. This will appear in

a ToolTip when placing the pointer over the
corresponding encoder name in the list on the left.
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SETTING UP THE ENCODING PARAMETERS

Select a channel ("Channel 1', or ‘Channel 2’ with CDM[3] PCX3) to set the
encoding parameters.

The encoding parameters fields displayed on the right depend on the encoder
model.

CDM-MPEG ENCODING PARAMETERS

o [T
= Channel 1

The available parameters for CDM[1], also called CDM-MPEG, are the following:

Setting Description

Media Server Media storage server where the encoded media files will be
stored.

Gop Size Number of frames between two | pictures (normal setting is

12). Defines the MPEG file structure to use.

Number of B Number of B frames between two P frames (typically 2).

Frames Defines the Gop structure to use.

Video Size Width of the picture. Select a value in the list (typically 352
for the lo-res and 720 for the hi-res, for a CDM-MPEG2).

Video Choose PAL or NTSC standard.

Standard

Format MPEG1
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Setting Description

Video Bitrate Video encoding bitrate, entered as a bit/sec number. For
example, 8Mb/s is entered as 8000000.

TC Config Defines the timecode inserted in the encoded file:

e vitc: the timecode is based on the video source signal.
Select vitc for all encoders in a lo-res + hi-res
configuration.

e |ocal time: the timecode is taken from the CDM encoder
local time.

e encoder config: the timecode is managed by the encoder
itself (from the CDM Manager application).

Audio Number of audio channels to encode and multiplex.

Numbers This is related to the audio configuration table that defines the

audio parameters for the encoded file.

Video Ratio Selection between 16/9 and 4/3 formats for encoding.

When you have done the required modifications, click on the Update button to
send the new parameters values to the encoder hardware.

CDM[2] AND CDM[3] ENCODING PARAMETERS

- % CDMHIRES

Audio Groups

Graup 1 Group2 | Group? || Groupd

Right Input

-

AHIRES_C.jpg

11



Issue 4.1.D

3.24

3.2.5

12

Xedio Suite Version 4.1 - User Manual — Xedio Manager
EVS Broadcast Equipment — December 2011

The available parameters for CDM[2] and CDM[3] are the following:

Setting Description

Profile Encoding profile used by the encoder.

The profiles come from a list of xml files stored on the storage
server (in the Profiles/CDM2 folder). These files define the
codecs/formats and their parameters.

Storage The storage server that stores the encoded media files.

Audio Groups This parameter is only available for CDM[2].

Only two groups of embedded audio can be selected
simultaneously.

Audio The audio sources can be chosen using the drop down lists in
Channels the selected groups.

Preview Thumb Path of the thumbnail, automatically generated by the
Path encoder, during video digitization.

This thumbnail is used in Xedio Ingest Organizer scheduler
and Xedio Manager to preview the source being encoded.

MODIFYING THE PHYSICAL ENCODER PROPERTIES

To modify the properties of a physical encoder, select it in the list, enter new
values in the relevant fields, and click the Update button.

POSSIBLE ACTIONS WITH CONTEXTUAL MENUS

A contextual menu is available when you select an encoder name in the list and
then right-click. The following options can be selected:

Menu Item Description

Duplicate Creates a new physical encoder with the same properties
and same encoding parameters. The term ‘duplicated’ is
added next to the new encoder name.

Delete Deletes the encoder configuration and removes it from the
list.

A contextual menu is available when you select a channel in the list and then
right-click:

Menu Item Description
Set Label / Opens a dialog box allowing to update the ‘Channel 1' or
Description ‘Channel 2' name or to enter a description.
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3.3

3.3.1

3.3.2

LOGICAL MANAGER

INTRODUCTION

When you click the Logical Manager button, the Logical Encoders Manager
window is displayed in the Work area, allowing you to logically group physical
encoders as being part of the same channel. Possible configurations use two
encoders in hi-res and lo-res or one encoder in hi-res only. With a XEDIO 1/0
encoder model, lo-res and hi-res are recorded by the same encoder.

Label :

Logical Encoder Group

Phyzical Low Bitrate Encoder :

igh Bitrate Encoder :

ot [default = 1024) :

CREATING LOGICAL ENCODER

To create and configure a logical encoder, complete the following fields and then
click on the Create button.

The logical encoder name is added to the list on the left side of the window and
the name of its corresponding physical encoders appears underneath.

Field Description

Label Give a name to the logical encoder.

Logical Encoder Select the group you want to link to the logical encoders.
Group This will determine the Ingest Organizer workstation which

will see the encoders and this is used to restrict the access
to some encoders by the Ingest Organizer.

The GLOBAL group makes the encoders visible to all the
Ingest Organizer workstations.

13
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Description

Physical Low
Bitrate Encoder

Select the low bitrate (if applicable) physical encoder to be
part of the logical encoder.

With a XEDIO 1/0 encoder model, selecting one of the
physical encoder channels automatically allocates the other
channel of the physical encoder to the corresponding low
bitrate or high bitrate field.

Physical High
Bitrate Encoder

Select the high bitrate physical encoder to be part of the
logical encoder.

Xedio Ingest IP
address

IP address of the server hosting the Xedio Ingest Organizer
module controlling the encoder.

Xedio Ingest TCP
Port

Port of the server hosting the Xedio Ingest Organizer
module.

Switcher Output

Output of the switcher to which the encoder is connected.

Color Background color of the encoder channel in the Xedio
Scheduler.
The color palette is available by clicking the Color button
and then selecting a color from the drop-down list.

Position Position of the encoder channel in the Xedio Scheduler.

Description Optional text to describe the logical encoder. This will

appear in a ToolTip when placing the pointer over the
corresponding logical encoder name in the list on the left.

MODIFYING THE LOGICAL ENCODER PROPERTIES

To modify the properties of a logical encoder, select it in the list, enter new values
in the relevant fields, and click the Update button.

POSSIBLE ACTIONS WITH CONTEXTUAL MENUS

DELETING A LOGICAL ENCODER

A contextual menu is available when you select a logical encoder name in the list
and then right-click:

Delete Logizal Encoder

Menu Item

Description

Delete Logical
Encoder

Deletes the logical encoder configuration and removes it
from the list.
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EXPORTING AND IMPORTING ENCODER PROPERTIES

A contextual menu is available when no encoder is selected and you right-click in

the encoder list area.

Menu Item

Description

Export Encoders

Exports the list and configuration of encoders in a
readable file (.enc format).

In the Save As window, select the folder to export the file
to.

Import Encoders

Imports the list and configuration of encoders in a
readable file.

In the Open window, select the file that contains the
encoders list to import.

15
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GROUP MANAGER

INTRODUCTION

When you click the Group Manager button, the Logical Encoder Group Manager
window is displayed in the Work area, allowing you to group together multiple
logical encoders.

A group of encoders will then be visible only to a predefined Xedio Ingest
Organizer workstation. Indeed, at first run of Xedio Ingest Organizer, the group
membership is set.

group 1

Logical encoder(z] :

CREATING A GROUP OF LOGICAL CHANNELS

To create a group of logical encoders, complete the following fields and then click
on the Create button.

The group name is added to the list on the left side of the window.

Field Description
Label Give a name to the group of logical encoder.
Description Optional text to describe the group of logical encoders.

Logical Encoders  Select the logical encoders to group together.
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3.4.3

3.5

0y Note 1

A group of logical channels restricts the amount of available channels for
specific Xedio Ingest Organizer workstations. There is one default group,
called GLOBAL, that allows a Xedio Ingest Organizer workstation to
“see” all channels when it is selected.

Oy Note 2

To finalize encoders configuration, it is necessary to store the CDM
encoders mapped drive in the database (see section 6.2.4 ‘Setting the
CDM Encoder Mapped Drive’ on page 37)

DELETING A GROUP OF ENCODERS

To be able to delete a group of encoders, you first need to clear the logical
encoders boxes and press the Update button.

Then, right-clicking the group name will show you a contextual menu with the
Delete option.

SCHEDULER

When you click the Scheduler button, the Scheduler window displays blocks
corresponding to the scheduled ingests already planned for encoding by all the
logical encoders.

Current Date

22/10/2003 15:04:16 - 271042003 12:0...

As this function is the same as the one available in Xedio Ingest Organizer, please
refer to the user manual of this application for more details.

17
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3.6 PREVIEW

When you click the Preview button, the Preview window displays simultaneously
the video currently under processing and encoding at all encoders inputs.

The only available parameter is the Refresh Rate defined in seconds.

Refresh Rate (in sec.)

18
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4.1

4.2

4. LinX and
Direct Access

INTRODUCTION

Xedio “Add-On” for EVS Video Server is based on LinX protocol and XT Gateway.
The LinX Application Programming Interface is an integrated API used to access
the EVS family video servers through Ethernet/IP connection.

Xedio can access EVS video server disks (e.g. XT[2], XS) and use the media
stored on EVS server thanks to XTGateway, provided that they have previously
been configured. Xedio will then be able to see, display, search and access clips
and record trains on EVS video servers. New clips could be created in CleanEdit
from EVS video servers.

Two items are available in the LinX category. They are detailed in the table below.

0 Server Group

Item Description

EVS Video Server Defines setup parameters for an EVS video server which
will be used by CleanEdit to see, display, search and
access clips and record trains.

EVS Video Server Defines the parameters of the web services used to
Group interact between Xedio and the EVS video servers.

All the steps below must be followed.

GENERAL CONFIGURATION
PARAMETERS

The following parameters must be defined from Softwares > Parameter Profiles >
General > General tab:

e Notification Center Address: set the IP address with port 48888.
Example: 172.22.23.9:48888
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e XedioBroker Address: set the IP address with port 8762.
Example: 172.22.23.9:8762

4.3 EVS VIDEO SERVER

4.3.1 INTRODUCTION

All the EVS Video Servers you want to access through LinX protocol must be
referenced in this category.

The Discover button helps you to “discover” automatically all the EVS Video
Server available on your network. If a server does not appear in the discovery,
you can try to restart the server or check the network path between the local
machine and your server (e.g. mutlicast shall be enabled), If it is still not
discovered, then configure the server manually.

When you click the EVS Video Server button, the EVS Video Server Manager
window is displayed in the Work area.

=T number

Channel Ganging
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4.3.2

EVS SERVER PARAMETERS

To set EVS video server parameters, complete the following fields and then click
on the Save button.

Field/Button Description

Server Name Name of the server to be accessed by Xedio, as you want
it to be displayed in the interface.

Description Optional text to describe the EVS Server.

FTP Interfaces (HCTX Connections)

IP Address 1 FTP IP address 1 of the EVS server you want to connect
to (mandatory).

IP Address 2 FTP IP address 2 of the EVS server you want to connect
to (optional).

FTP Login Login ID defined on the EVS server (e.g. evs).

FTP Password Password defined on the EVS server (e.g. evs).

Control & Management Interface (PC LAN Connection)

IP Address PC LAN IP address of the EVS server you want to connect
to (mandatory).

Connect Checks the connection with the selected EVS server.

Discover Opens a window which lists the EVS video servers from

the network and their corresponding PC LAN IP address.

Setup Opens a dialog box which allows to set the AVSP
guardbands length of clips created with LinX (e.g. 5 sec 0
frame).

Control Mgt Interface - Configuration

B8WSP Guard Band

Seconds Frames

Wiarning ¢ maximurn guard band size is 5 minutes

Configuration List Displays the list of configurations available from the
server.
Apply Applies the selected configuration.
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Field/Button Description

/0 Channel Displays the list of recorder channels from the selected
EVS server.

Button Description

Delete Deletes the selected EVS server from the tree structure.

Refresh Checks whether the EVS video server is reachable. If yes,

the server configuration is retrieved. If not, the server
name and server icon are displayed in red.

Save Saves the parameters entered for the server.

Clear Clears the parameters entered for the server.

How TO GANG RECORDER CHANNELS

You can gang several recorder channels from an EVS video server. To do so,
proceed as follows:

1. Select several recorder channels in the I/O Channels area,
2. Right-click the list.

3. Select Gang.

The ganged channels are mentioned in the Ganging column.

POSSIBLE ACTIONS WITH CONTEXTUAL MENUS

A right-click on a server displays a contextual menu with the following option:

Menu Item Description

Delete XT Deletes the selected EVS server from the tree structure.
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4.4 EVS VIDEO SERVER GROUP

When you click the EVS Video Server Group button, the EVS Video Server Group
Manager window is displayed in the Work area.

To set a group of EVS video server, complete the following fields, select the
servers you want to group and then click on the Create button.

Field Description

Label Name you want to give to the group of servers.
Description Optional text to describe the group of EVS Servers.
LinxAdapter IP address of the machine hosting the LinxAdapter

software, used to manage the Linx notifications from the
EVS video server to Xedio. Keep 80 for TCP Port and
keep the soap string unchanged.

LinxAdapter Backup  Not used. Keep 0.0.0.0.

LinxOutAdapter IP address of the machine hosting the LinxOutAdapter
software, used to manage the Linx commands sent from
Xedio to the EVS video server. Keep 80 for TCP Port and
keep the soap string unchanged.

EVS video servers List of EVS video servers defined in the EVS Video
Server tab. Select the servers you want to include in the
group. All the EVS servers which must be seen and could
be used in CleanEdit must be assigned to a group.

Mandatory.
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5. Machines

5.1 INTRODUCTION

External devices can be connected to the Xedio Suite. Their parameters are
configured from the Machines tab.

Four items are available in the Machines category. They are detailed in the table

below.

Machines

t anager

LiF]

[IF]Director

[tem

Description

VTR Manager

Defines setup parameters for a controlled VTR.

Switcher Manager

Defines setup parameters for a switcher connected to the
system.

Archive Servers

Defines setup parameters for a server used to archive
media.

XFile Manager

Defines setup parameters for an XFile used for rendering.

IPDirector

Defines setup parameters to use information coming from
IPDirector API.
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5.2 VTR MANAGER

A VTR can be used as a source of ingest. The VTR video output must be
connected to the encoder video input.

When you click the VTR Manager button, the VTR Manager window is displayed in
the Work area.

1.1 100 . 102

COM1

Switcher Input : [ empty = no uzed |

To set VTR parameters, complete the following fields and then click on the Save

button.

Field Description

ID Number automatically allocated by the system when you
save the VTR configuration.

Label Name you give to the VTR device.

Description Optional text to describe the VTR device.

Xedio Ingest IP address of the server hosting the Xedio Ingest

Organizer IP Organizer module controlling the VTR to be used.

Serial COM Port Port used by the workstation when sending data and
transport control commands to the VTR (in RS-422).

Switcher Input Switcher device to which the video source of the VTR is

connected. Leave this field blank if you do not have any
switcher control device supporting Xedio protocol.
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SWITCHER MANAGER

When you click the Switcher Manager button, the Switcher Manager window is
displayed in the Work area.

Tranzmit Switcher [nfo

Switcher Config Host [P : Clon . 107 b achine M arme

Switcher Config Host Part :

nze Timedut [in

Apply

You can indirectly control a switcher through the system. If the Transmit Switcher
Info field is checked, Xedio Ingest Server application transmits the switching
information over the Ethernet network to a dedicated software device before
starting any recording. This device will manage the audio and video routing at the
switcher with regard to its brand and protocol, and send an acknowledgement back
to Xedio Ingest Server within a determined delay in order to start the encoder(s).

To set switcher parameters, complete the following fields and then click on the
Apply button.

Field Description
Transmit Switcher Enables/Disables the use of a software device to control
Info the switcher(s)

Switcher Config Host |P address of the software device to access to.
P

Switcher Config Host Port number where to send the switching information.
Port

Wait For Host Delay for the "acknowledge” coming from the device.
Response TimeOut

(in sec.) \;\2} Note
When timeout delay is reached, Xedio Ingest
Server aborts the recording process.
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The protocol used between Xedio Ingest Server and the “switching device” uses

the following commands:

Commands sent from CleanGest Server

to the switching device

<ConnectPorts InPort="x" OutPort="y

<ReleasePorts InPort="x" OutPort="y

Description

Used before starting a record

Used at the end of a record.

The answers received from the device must be as follows:

Received from the software device

<ConnectOK/>

<ConnectFailed/>

<ReleaseOK/>

<ReleaseFailed/>

<CmdErr/>

Description

Possible answers following a
“ConnectPorts” command.

Possible answers following a
“ReleasePorts” command.

Error status
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5.4 ARCHIVE SERVER MANAGER

When an Archive Server is attached to a Xedio installation, it must be referenced
in the database.

When you click the Archives Servers Manager button, the Archive Servers
window is displayed in the Work area.

. 100, 101

To set archive server parameters, complete the following fields and then click on
the Save button.

Field Description

ID Number automatically allocated by the system when you
save the Archive Server configuration.

Label Name you give to the Archive Server.

Description Optional text to describe the Archive Server.

IP Address IP address of the archive server.

Is default When selected, the current archive server is used by
default.
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9.9

XFILE MANAGER

XFile can be used to receive and send media in file format or for the rendering of
files to an EVS video server.

When you click the XFile Manager button, the XFile Manager window is displayed
in the Work area.

70110 HiResFiles)

To set XFile parameters, complete the following fields and then click on the Save
button.

Field Description

ID Number automatically allocated by the system when you
save the XFile configuration.

Label Name you give to XFile.

Description Optional text to describe the XFile.

XFile IP Address IP address of the machine hosting XFile software.

Root XML Path Location where an XML file is sent by Xedio to request a
job.

Media Path Location where the media is stored before being treated
by XFile.

Default XT EVS video server number used by default to store media

files treated by XFile.

Default Page EVS server page number used by default to store media
files treated by XFile. If the field is left empty, the first
available place will be used.

Default Cam EVS server cam number used by default to store media
files treated by XFile. If the field is left empty, the first
available place will be used.
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IPDIRECTOR

It is possible to synchronize the Xedio database with the IPDirector database.

The IPD Gateway is a Windows service used to synchronize database information
from IPDirector to Xedio. It subscribes to IPDirector Notification Server.

The IPDirector Notification Server is an IPDirector API which is used to notify the
gateway when modifications are done in the IPDirector database.

A Important

When the IPD Gateway has been installed, it must be configured in
Xedio Manager and the IPD nearlines must be configured in the Xedio
Media Servers of Xedio Manager before you start the IPD Gateway
services.

When you click the IPDirector button, the IPDirector window is displayed in the
Work area.

IPDirectar Gateway IPDirector Database
IF Address IF Address

Database name

TZP Pork 0

Passwiord

Create M

Update Il

Delete Il

Full

To set IPDirector parameters, complete the following fields and then click on the
Update button.

Field Description

IPDirector Gateway

IP Address IP address of the machine where the IPDirector gateway
is installed.
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Description

TCP Port

IPD gateway TCP port (default is 8080)

Domain User

“\<Windows Domain User with Admin rights>’

Domain Password

Windows Domain Password for this user

IPDirector Notification Server

IP Address IP address of the machine where the IPD API is installed.

TCP Port IPD API TCP port.

Login Login for the IPD Notification Server

Password Password for the IPD Notification Server

Create When selected, the ‘create’ operations in IPDirector are
notified.

Update When selected, the ‘update’ operations in IPDirector are
notified.

Delete When selected, the ‘deletee’ operations in IPDirector are

notified.

IPDirector Database

IP Address

IP address of the machine where the IPD database is
installed.

Database Name

Name of the server where the IPD database is located.

Login

IPD database username.

Password

IPD database password.

Each time the configuration is modifying, click the Full Resync button to force a
full resynchronization from IPDirector to Xedio. A confirmation dialog box then
opens where users enter the dates interval to be taken into account for the

resynchronization.
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MODIFYING OR DELETING AN EXTERNAL
DEVICE

To modify the properties of one of the previous external devices, except a
switcher, select it in the list, enter new values in the relevant fields, and click the

Update button.

Update

To delete one of the previous external devices, except a switcher, select it in the
list, right-click and select Delete from the contextual menu.

Delete
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6.1 INTRODUCTION

From the Media category you can define the media storage tree structure and
media classes, you can import and manage media files.

Five items are available in the Medias category. They are detailed in the table
below.

RTD Manager

=]

I anager

[tem Description

Servers Allows to define the media storage server(s) and to
create its sub-folders (multiple storage servers may be
defined).

Class Manager Allows to define a Class List to categorize the stored
media.

Media Importer Allows to import media files into the storage server and to

create a reference to the files within the database.

RTD Manager Manages the animated transition graphics (RTD’s)
referenced in the database.

Manager Manages the media files within the database and the
storage server.
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6.2 MEDIA SERVERS

6.2.1 INTRODUCTION

A Media Server is the location where all the media used within a Xedio installation
will be stored.

When you click the Media > Servers button, the Media Servers window is
displayed in the Work area, allowing you to define a media server.

6.2.2 ADDING A MEDIA SERVER

To add a media server, proceed as follows:

1. Right-click in the Media Server window and select New Media Server in the
contextual menu. A wizard opens.

Iair P :

Dramain Marme :

Cancel

2. Complete the fields described in the following table:

Field Description

Login Name Login name defined for the media server in its
configuration parameters.

Login Password Login password defined for the media server in
its configuration parameters.

Main IP IP address of the server used for media storage.
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6.2.3

7.

8.

Domain Name Field automatically filled when an IP address is
entered
Backup IP IP address of the backup storage server, when a

redundant network is used.

Click Next.
The next page displays the drives capacity of the new media server.

Click Next.

Select the drive(s) for the storage and enter a base path for the sub-folders
that will be created by the system.

Click Next.
Type a name for the server in the Label field.

Click Finish.

The tree structure of the media server is displayed.

1.1.7001

m HIRES

I | OWRES

W VOICEOVER
MSTILL

M AUDID

M| FPLST

I MEDIATHUMB
N CLIPTHUMB
I TAGS

MRTD

I PROFILES

N CACHE

N CUEPOINTTHUMB
M SETTINGS

M CG

CONTEXTUAL MENUS

A contextual menu is available when you select a media server in the list and then

right-click:

Menu Item Description

New Media Server Adds a media server storage: displays the folders present
in the path selected for use as media server.

Rename Media Allows to update the media server label.

Server
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Description

Delete Media Server

Deletes the media server view in the Media Servers
window.

Modify Media Server
Description

Opens the Media Server Modification window allowing to
update the label or description of the media server.

Media File Cleaner

Opens the Media File Cleaner window. Refer to section 12
‘Media File Cleaner’ on page 127 for more information.

A contextual menu is available when you select a folder in the list and then right-

click:

Menu Item

Description

New Media Server

Adds a media server storage: displays the folders present
in the path selected for use as media server.

Default ‘Folder Name
Files’ Directory

Sets the selected folder as default folder for the type of
files (bitmaps, video files, thumbnails etc...). The folder
icon is then green.

This is only necessary when multiple storage servers are
created in the system. This tells the system to use a
specific storage server for some files and another server
for other files. The Default folders may be changed at any
time without losing previously stored material.

Example: for the HIRES folder, the option is Default
‘HiResFiles’ Directory and sets the HIRES folder as
default for the hi-res files.

Delete Media Removes the media folder from the Media Servers
Directory window.
Collect Media Displays the list of media present in the selected folder.

Media File Cleaner

Opens the Media File Cleaner window. Refer to section 12
‘Media File Cleaner’ on page 127 for more information.
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6.2.4

6.3

6.3.1

SETTING THE CDM ENCODER MAPPED DRIVE

The physical encoder is usually configured to store the encoded files on a specific
mapped drive, usually called “G” or “H". This mapped drive letter also has to be
stored in the database in the CDM Mapping column.

To set or change the encoder mapped drive, proceed as follows:
1. In the Medias Servers window, click twice (not a double click, click then wait

and click again) the mapped drive letter related to the requested server in
the CDM mapping column.

2. Select the requested CDM mapped drive from the drop-down list.

The encoder mapped drive has been set or changed.

CLASS MANAGER

INTRODUCTION

The Class Manager tool is used to define and manage the ClassList. Classes
categorize the media and the virtual media. They are mainly used in the database
lists from the Xedio Suite to perform search on media. Media are assigned to
classes through the Xedio applications such as Xedio Ingest Organizer, Xedio
Importer, Xedio AutoFile Importer or Xedio Browse applications.

When you click the Class Manager button, the Media Class Manager window is
displayed in the Work area, allowing you to create new media classes and sub-
classes.
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POSSIBLE ACTIONS WITH CONTEXTUAL MENUS

A contextual menu is available when no class is selected and you right-click in the
Media Class Manager window.

Menu Item Description

New Root Creates a new class of media.

A contextual menu is available when you select a Class in the list and then right-
click:

Menu Item Description

New Root Creates a new class of media.

New Child Creates a new sub-class of media.

Rename Allows to rename the selected class or sub-class.

Modify Opens the Modify Class window allowing to update the
label or description of the selected class or sub-class.

Delete Deletes the selected class or sub-class.

Hidden State Hides/Unhides the selected class or sub-class so users

cannot/can use it.

MEDIA IMPORTER

The Media Importer is the tool used to import, into the Xedio database, media that
have already been recorded and are in a file format that can be used by Xedio.
P2, XDCAM and XDCAM EX, music, graphics or existing mpeg and dv files are
some examples.

The Xedio Importer is available as:
e a separate application
e as a module built in CleanEdit, and available in the Media Importer tab.

e as a module built in Xedio Manager, and available in the Media category,
Media Importer tool.

When you click the Media Importer button, the Media Importer window is
displayed in the Work area. It presents different sub-tabs to set the parameters for
different types of media to be imported into the system, such as:

e XDCAM, XDCAMEX, P2 and CANON tabs

To import media files recorded on Sony XDCAM and XDCAMEX, Panasonic P2
and CANON cameras

e Video/Audio/Stills tab

To import media files, images or audio files
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e RTD tab
To import video containing transitions
e EVS Server tab

To import media files available on an EVS server on the same network as the
Xedio suite. In this case, Xedio does not import the file content into the Xedio
storage system, but creates a reference to the server files in the Xedio
database.

Refer to the Xedio Importer user manual for a comprehensive description of the
tabs and fields.

HIGH BITRATE
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RTD MANAGER

INTRODUCTION

When you click the RTD Manager button,the RTD Manager window is displayed in
the Work area, allowing you to import or manage the transition sequences. The list
displays the available effects stored in the system.

L_INTERLACE 00
L_INTERLACE 0

POSSIBLE ACTIONS WITH CONTEXTUAL MENUS

A contextual menu is available when no RTD is selected and you right-click in the
RTD Manager window.

Menu Item Description

Import Imports a transition effect.

A contextual menu is available when you select a RTD in the list and then right-
click:

Menu Item Description

Import Imports a transition effect.

Preview Allows to preview the selected transition effect.

Edit Opens the Update RTD Label window allowing to update

the label or description of the selected effect.

Delete Deletes the selected effect from the database. It can only
be removed if it is not already used in an edit, otherwise,
an error message will occur.

Video Standard Allows to select a video standard among PAL SD, NTSC
drop SD, HD 1080i @50, HD 720p @50, HD 1080i
@59,94, HD 720p @59,94, HD 1080p @50, HD 1080p
@59,94.

Used by Opens a window to show in which projects the selected
media is used in:
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6.6 MEDIA MANAGER

6.6.1 INTRODUCTION

The Media Manager tool is designed to give an overview of the database content,
to edit some media properties and to delete media files from the database and
from the storage server(s). Different search tools can be applied to the database
content to help users to find specific media.

Oy Note

Only items that are not used (not locked) in any user project and not
used to create virtual media and/or clip can be deleted; otherwise, an
error message will occur.

The media items displayed in the Media Manager window are all the media items
corresponding to the filters or search tools applied.

When you click the Media > Manager button, the Media Manager window is
displayed in the Work area.

Class Wedia Categon - | Label il il iphis Creation Date lodification Date | Shooting Date

pasuod Aepoy ()4

Undefined @\ Concet_COO0T0_13h53 24-03-2003 135317 %6-10-2010 11:07:52 24-09-2003
Undefined @\ Concet_CON020_14h00 24-03-2003 14:00:12 17-10-2010 15:39:28 24-09-2003
Undefined @ Concer_CO0030_14h00 4-09-200914:00:12 6-10-2010 11:07.53 24-03-2003

Undefined @ Concer_CO0040_14h00 i S } 24-09-200914:00:12 6-10-2010 11:07.53 24-03-2003

Undefined @\ Concer_CO0050_14h00 - [ 4-09-200914:00:15 6-10-2010 11:07.54 24-03-2003

Undefined @\ Athletizrne_CO0010_14h03 . ? 24-09-2003 14:03:39 :6-10-2010 11:07.55 24-03-2003
Undefined @\ Athletizrne_CO0020_14h03 | - | St 4-09-200914:03:39 26-10-2010 11:07.55 24-03-2003
Undefined @\ Athletizre_CO0030_14h03 z 24-09-2009 14:03:40 6-10-2010 11:07.56 24-03-2003

Undefined @\ Athletizre_CO0040_14h03 - 24-09-2003 14:03:40 26-10-2010 11:07.55 24-03-2003

The upper part of the Work area gives access to the different filters which can be
applied to the media list.

At least two tabs exist on the left of the Media Manager window.

e The Filter 0 tab: The element grid displays the list of all media present in the
database, or it returns the result of a search applied to the list.
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ﬁ e The Today tab: the element grid shown the media with ‘creation date = today’.

Additional tabs are displayed when the users have saved filters applied to the
database. Refer to section ‘Using Saved Filters’ on page 53 for more details.

Media items are displayed in columns.

6.6.2 ELEMENT GRID

DISPLAYED COLUMNS

It is possible to re-arrange the columns order, and to add or remove some
columns.

Right-clicking on any of the column headings displays a contextual menu. The
Choose Displayed Columns option opens the Select Visible Columns window
allowing you to choose the columns you want to be displayed in the element grid.

The column width and order can be adjusted using standard computer commands
and drag and drop techniques.

ELEMENT GRID CONTEXTUAL MENU

A contextual menu is available when you right-click on an item in the list.

Menu Item Description

Published State Allows the selection of a sub-menu to change the publish
state of the media between Published and Not
Published. A published media will be displayed in the
database lists of all the software and thus available for
use.

Treated State Allows the selection of a sub-menu to change the treated
state of the media between Treated and Not Treated. A
media can be set as treated when virtual media have
been created from this media in Xedio Browse.

Deleted State Allows the selection of a sub-menu to change the deleted
state of the media between Deleted and Not Deleted.

Video Standard Allows to change the metadata for the media to PAL or
NTSC and vice versa. This only affects the flag in the
metadata and does not affect the media (to allow for a
correction in the data only).

Video Ratio Allows to change the metadata for the media between 4/3,
16/9, and unknown. This only affects the flag in the
metadata and does not affect the media (to allow for a
correction in the data only).

Media File(s) Status  Allows the selection of sub-menu to change the status of
the low bitrate file or the high bitrate file between Rec
Done, Imported, Rec Error, Archived, ArchiDel,
Restored, Deleted and Imported Error.
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Menu Item

Issue 4.1.D

Description

Set Audio Track

Allows to set or update the audio track assignment for

Assignment selected media (8 audio or 5.1). Refer to section ‘How to
Define New Default Audio Channel Assignment’ on page
72 for explanation.

Properties Displays the properties for the selected media. If a

default metadata profile has been defined for the media, a
metadata tab is displayed and allows to modify the media
metadata values.

Delete Media &
Purge

See section 6.6.4 ‘Delete & Purge’ on page 55.

Force Delete

Deletes a media with all the references of its use in the
database. If it is used in an edit, this will cause “holes” in
the edit. This option must be used very cautiously.

Play

Opens a new Player window to allow the low bitrate file or
the high bitrate file to be browsed.

Media Analyzer

Opens a Timecode Extractor window showing an analysis
of the selected file.

MOS Publication

Allows to send a notification to the news room system.

Merge

This option is used to associate a lo-res media to a hi-res
media.

Opens the Get Lowres File window allowing you to browse
for the lo-res file.

Generate Low
Resolution Media
File

Generates missing lo-res media file from the hi-res media
file. Refer to section ‘Generate Low Resolution Media
Files’ on page 44.

Retrim

In case the TC IN or TC OUT of a media hi-res and lo-res
files differ, this option will automatically adjust both files
to the same TC range.

Create Missing
Thumbnails

This option creates thumbnails in the Thumbnail IN and
Thumbnail OUT columns of the Work area.

43



Issue 4.1.D

44

Xedio Suite Version 4.1 - User Manual — Xedio Manager
EVS Broadcast Equipment — December 2011

Menu Item Description

Used By Opens a window to show in which projects and edits the

selected media is used in:

]
Rugby_Edit_1
- Clipls)

Clip_001

GENERATE LOW RESOLUTION MEDIA FILES

When several files are selected from the list and you select the Generate Low
Resolution Media File option, several cases can occur.

1.

Some hi-res files are not present on the Media server (they could be offline
or ARCHIDEL)

A popup window is displayed and lists those missing files. You are asked
whether you want to continue.

e Press YES to generate only lo-res files corresponding to existing hi-res
files

e Press NO to cancel the operation.
The hi-res files are online and at least one lo-res file already exists on the
Media server or is ‘ARCHIDEL".

A popup window is displayed and mentions that existing file. You are asked
whether you want to overwrite this lo-res file.

e Press YES to overwrite the existing lo-res file.

If the Do this for all selected media option is selected, the check will
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6.6.3

not be applied on the other files and all the existing lo-res files will be
generated.

e Press NO to avoid the replacement of existing lo-res files.

If the Do this for all selected media option is selected, the check will
not be applied on the other files and only the offline lo-res files will be
generated.

3. The hi-res files are online and at least one lo-res file is in use.

A popup window is displayed and mentions the file in use. You are asked
whether you want to continue.

e Press YES to generate only lo-res files not in use.

e Press NO to cancel the operation.

SPECIAL STATUS DISPLAY FOR THE ELEMENTS

The elements can be displayed with a specific font to reflect a particular status.

Element Display Meaning

Red font Element in recording or importing state. A wrong status
may be displayed when a Xedio Ingest server crashed.

[talic font Virtual media created with Xedio Browse.

Grey font Only hi-res media or lo-res media is available.

SEARCHING THE DATABASE

INTRODUCTION

When the database contains large amounts of data, it may become difficult to find
a specific element. The Xedio Suite offers several ways to speed up your search:

e (uick text search

o filters on parameters

By default, the columns that are taken into consideration for the Quick Text
Search are the ones currently visible in the grid.

If you wish to search in other columns, and view the string you are searching for
in the columns, you can:

e add other columns to the element grid view
e use Filters, as explained in section ‘Advanced Filters’ on page 47
These search tools are explained in detail below.

Quick text search and filters on parameters, as well as several filters on
parameters, can be combined and saved for later use. All the criteria must be met
in the results list (an ‘AND’ operator is applied). These Saved Filters can then be
applied in one click.
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QUICK TEXT SEARCH

Introduction

The Quick Text Search field is always available on the top of the database
content list:

It allows searching for a string in the displayed columns.

The Quick Text Search option obeys specific rules which can be accessed via the
Help button next to the Quick Text Search field.

For more details on these rules, refer to the section ‘Quick Text Search Rules’, on
page 47.

How to Perform a Quick Text Search
To perform a Quick Text search, proceed as follows:
1. Show the columns you wish to perform a quick search on.

2. Type a search string in the Quick Text Search field, based on Quick Text

search rules available from the Help button and detailed in section
‘Quick Text Search Rules’ on page 47.

€ EH =

3. Depending on whether the AutoRefresh Filtering setting is selected or not,
you may have to press the Search button to apply the Quick Text Search.
Refer to the tab Software > Parameter Profiles > General > General.

The Quick Text Search is applied and the search result is displayed in the
grid.
4, To clear the applied Quick Text Search, click the red "X" icon to the right of
the search field nor select <empty> from the Quick Text Search field.
5. The Quick Text Search field is a combo box that gives access to the last 10
previously searched strings.

Select a filter from the list of the Quick Text Search field to apply a
previous search.

< empky

athl
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Quick Text Search Rules

The string that you enter in the Quick Text Search field is analyzed according to

the following set of rules, which can be accessed via the Help button next to
the Quick Text Search field.

The free text search is not a case sensitive operation.

Search String

Search Result

Yellow card Searches for the strings ‘yellow’ and ‘card’, even if in two
different fields (columns), for example ‘yellow’ in Name and
‘card’ in Keywords.
For example a clip named ‘The Yellow Man' with keywords ‘Red
Card’ will be found, since it has yellow and card in 2 different
fields.

"Yellow card" | Searches for strings containing ‘Yellow card’.

Yellow | card

Searches for ‘yellow’ or ‘card’, even if in two different fields
(columns), for example ‘yellow’ in Name or ‘card’ in Keywords.

Spaces around the | sign are mandatory.

yell* Searches for ‘yell” at the beginning of a string.

*low Searches for ‘low’ at the end of a string.

Ye*low Searches for strings with 'ye’ at the beginning and ‘low’ at the
end.

Ye*low 123 Searches for strings with ‘ye’ at the beginning and ‘low’ at the
end and which contains *123".

=card Searches for a string exactly equals to ‘card’.
For example, if a field contains ‘yellow card’, the =card condition
will not return any result.

="yellow card” | Searches for a string exactly equals to ‘yellow card’.

The use of quotes is required due to the space between ‘yellow’
and ‘card’.

ADVANCED FILTERS

Filters are available for more detailed search operations from the Filter 0 tab. The
parameters available for filtering operations are the column headings and any
metadata associated by the user.

From the Today tab, the filter ‘creation date = today’ is automatically applied.
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Filter Activation

Show/Hide Filter Button

To display, or hide, the Filter extended area, click the Show/Hide Filter button
over the grid.

Filter Button Display Meaning

_ The Show/Hide Filter button is dimmed when all filter

(dimmed) criteria are hidden. Consequently, the filters are inactive.

n The Show/Hide Filter button is red when the filter

(red) extended area is visible, even if no filtering criterion is
applied.

Filter Extended Area
The Filter extended area is as follows:

]

ALL Criteria are met - =

The first field under the Show/Hide Filter button lists three options for the
combination of criteria to be taken into account during the filtering operation.

MO Criten

The second field is a filter field allowing the users to select a first filter parameter.

Criteria Combination

The available options are detailed in the table below:

Option Meaning

ALL criteria are met  All the criteria selected in the Filter fields displayed
under the Criteria Combination field must be met.

The media displayed in the results list fulfill all the
selected filter criteria.

ANY criteria is met At least one of the criteria selected in the Filter fields
must be met.

The media displayed in the results list fulfill at least one
of the selected filter criteria.

NO criteria is met None of the criteria selected in the Filter fields displayed
under the Criteria Combination field must be met.

The media displayed in the results list fulfill none of the
selected filter criteria.
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Filter Fields

Under the Criteria Combination field, the users will be able to select as many
filter parameters as they want and to choose specific value(s) for these filter
parameters. The use of Filter fields is explained in the next section.

Filter Fields

The Filter field provides the list of all the parameters on which a search can be
performed. The following screenshot is an example of such a list. The options may
differ between the applications of the Xedio Suite. Most relevant parameters are
listed at the top of the list, then, all the other fields are displayed in alphabetical
order.

GEC]

Interface Element Description
1 Selected filter parameter.
2 Various fields used to enter the filter criteria. Refer to

section ‘Search Fields Types’ on page 50.
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Description

Used to remove the corresponding filter line.

Used to add a new filter line.

Search Fields Types

According to the selected filter parameter, different types of search fields will be
displayed. They are detailed in the table below.

Filter Parameter
Type

Displayed Criteria Fields

Timecode or
Duration
Parameter

Such as TC IN,
TC OUT,
Duration...

Select a logical operator in the first field and then enter a
timecode or duration value in the second field.

Range

Such as
Timecode Range

Select an option from the first field and then enter a timecode
value. This will include, or exclude, media containing the
specified timecode value.

Date

Such as
Creation Date

Several Date Search filters exist. They are described below.

a. Select a condition or a logical operator in the first field

g1

b. This will condition the next step:
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Filter Parameter Displayed Criteria Fields

Type

e Search based on a specific date (e.g. with =...): a calendar
will be displayed for the selection of a date.

ug/11
August, 2011
Today: 22/Augfll

e Search based on an interval (e.g. with [...] (between)...): two
calendars are displayed for the selection of two dates.

e Search based on a specific date calculated from the current
date (e.g. with tomorrow, last month,...): no other field
appears.

bornorrow
Time Several Date Search filters exist. They are described below.
Such as Last a. Select a condition or a logical operator in the first field
Rendered Date
Time 22480011 162012

b. This will condition the next step:

e Search based on a specific date and time (e.g. with =...): two
additional fields will be displayed, a calendar for the
selection of a date and drop-down list for the selection of
time.

e Search based on a specific date and time calculated from
the current date and time (e.g. with next hour, last
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Displayed Criteria Fields

Type
month,...): no other field appears.
fornarraw
Number
Such as DB Id
Select a logical operator in the first field and then enter a
number in the second field.
@ Note
<> means ‘differs from’
Option List Select a condition in the first field
Such as Video
Standard
Click the - button to display the list of options available for
the selected filter parameter.
Example for the Video Standard:
oStandard B PAL 5D
I HD 1080 250
M HD 720p (350
B HD 1080p @50
M HTSC drop SD
M HD 10&0
B HD 720p
Select an option from the list.
Boolean Select Yes or No from the single criteria field
Such as
Published
Free Text contain:

Such as Label

Select a condition in the first field and then enter text in the
second field.
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How to Perform a Search through Filter Fields

To enter search values in the Filter fields, proceed as follows:

1.

2.

Choose the columns you wish to perform a search on.

i
Click the Show/Hide Filter button

The following Filter area is displayed:

ALL Criteria are met =

Select a criteria combination from the list:

MO Critena iz met

Select a filter parameter from the filter parameter list.

An entire line, corresponding to the selected filter parameter, is displayed:

ALL Criteria are met

Lamera

Enter filter criteria as explained in section ‘Search Fields Types’ on page
50.

For free text fields, press ENTER to apply the filter.

Otherwise, the results list is automatically restricted.

If required, click the button to add a filter parameter.

USING SAVED FILTERS

Once you have defined a filter criterion, you may want to save it for later use. You
will then be able to apply the same filter with a single click.

Right-clicking in the Filter 0 tab displays a contextual menu with the following
options:

Create Mew Filker
Save Filker As
Filker Properties
Reset Filker
Delete Filker
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Menu Option Description

Create New Filter Allows to create a new filter tab.

Save Filter As Allows to create a new filter tab in which the current

search filter will be saved.

Filter Properties Allows to change the name and/or description of the

selected filter tab.

Reset Filter Removes all search criteria on the selected filter tab.

Delete Filter Removes the filter tab.

How to Save Filters

To save filters, proceed as follows:

1.

2.

Define the filter or filters combination you wish to save, as explained above.
Right-click the Filter 0 tab.

Select Save Filter As from the contextual menu.

The Filter Edit Dialog box opens.

Enter a label for the tab you are going to create and, if required, enter a
description.

Click OK to confirm.
The new filter tab is displayed on the left of the list.

How to Apply a Saved Filter

To apply a saved filter, simply click the corresponding tab.
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6.6.4 DELETE & PURGE

The Delete Media(s) & Purge function allows the user to remove unused media
from the media server while deleting the media from the database.

There are four options available when using this function:
1. Delete database references: removes entries from the database only

2. Delete database references AND media files from online (e.g. XT[2]) or
nearline (e.g. SAN, XStore) storage: removes entries from the database and
from the media server

3. Delete database references AND media files from offline/deep archive (e.g.
Tape library, ftp archive): removes entries from the database and from the
archive storage

4. Delete database references AND media files from online/nearline storage AND
media files from offline/deep archive: removes entries from the database, from
the media server and from the archive storage

The media will be removed only if they are not used in other edits or in other
playlists (either the media itself or through attached virtual media or virtual clips).

Additionally, all associated material such as virtual media and virtual clips that are
used in the edit(s) or playlist(s) selected for deletion will be removed from the
database.

For more powerful media delete and purge options, see sections 12 ‘Media File
Cleaner’ on page 127.
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/. Metadata

7.1 INTRODUCTION

Metadata is customer-defined data which can be associated with media or edits to
describe or classify them.

Metadata user fields can be created and associated into profiles within Xedio
Manager. Then, a metadata profile can be assigned to media or edits and
metadata values specific to the media or edit can be entered in the user fields.

Three items are available in the Metadata category. They are detailed in the table
below.

Metadatas

Media Profi

Edit Profil

[tem Description

Profile Management Manages the creation of metadata fields and their
association into metadata profiles.

Media Profile Allows the selection of metadata profiles to be available
Association for association with media.
Edit Profile Allows the selection of metadata profiles to be available
Association for association with an edit.
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7.2 PROFILE MANAGEMENT

When you click the Profile Management button, the Metadata Profiles
Management window is displayed in the Work area, allowing you to define user
fields and to associate them into profiles. It is divided into three areas:

1. Available Metadata Fields
2. Metadata Profile Information
3. Existing Metadata Profiles

etadata Profile
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MANAGING USER FIELDS

CREATING USER FIELDS

To create a user field, press the Add New Field button in the Available Metadata
Fields area, complete the following fields and then click on the OK button.

Field Description
Field Name Name you want to give to the user field.
Type Six types of user fields are available. They will appear as

follows in Xedio CleanEdit:

Boolean True or False values.

Combo Drop-down list of values defined at
creation
Date Date field with drop-down arrow giving

access to a calendar.

Number Number field with up and down arrows to
increase or decrease the value.

Text Free text field

Timecode Timecode field

Default Values Possibility to define a default value to be used for the
user field. The default value is enabled when the Default
Values button is surrounded by a red line.

Description Optional text to describe the user field.

Field Values (combo Right-click in the field and select New to define a value
option) for the drop-down list.

MODIFYING A USER FIELD

To modify the properties of a user field, select it in the list, click the Modify Field
button, enter new values in the relevant fields, and click the OK button.

If the user field is used in a profile, only the Label and the Description fields can
be edited.

DELETING A USER FIELD

To delete a user field, select it in the list and click the Delete Field button. It can
only be deleted if it is not used in a profile.
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1.2.2

MANAGING METADATA PROFILES

CREATING A METADATA PROFILE

To create a metadata profile, complete the following fields in the Metadata Profile
Information area and then click on the Save Profile button. It will then be
displayed in the Metadata Profiles area.

Field Description

ID Automatically filled by the system.

Label Name you give to the profile.

Description Optional text to describe the metadata profile.

Field(s) List of user fields you want to use in the profile: select a

user field in the Available Metadata Fields area and drag
it to the Metadata Profile Information area.

MODIFYING A METADATA PROFILE

To modify a metadata profile, select it in the Metadata Profiles area, enter new
values in the relevant fields, and click the Save Profile button.

[t can only be edited if it is not selected for use in the Media or Edit Profile
Association.

DELETING A METADATA PROFILE

To delete a metadata profile, select it in the Metadata Profiles area and click the
Delete Profile button in the Metadata Profile Information area.

It can only be deleted if it is not selected for use in the Media or Edit Profile
Association.
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7.3 MEDIA PROFILE ASSOCIATION

When you click the Media Profile Association button, the Media Metadata Profile
Table Association window is displayed in the Work area, allowing you to select the
profiles you want to make available to the users.

Descripkion :

Available : Selected :

Cup Metadata Profile

Default Profile : test

The following fields are displayed in the window:

Field Description

Description Automatically filled by the system for the selected profile
with the description text entered at profile creation.

Available Displays the list of existing profiles available for
selection.
Selected Displays the list of profiles which have been selected in

the Available list and added thanks to the Add button.
Profiles can be removed from the Selected list and be
made available in the Available list again by using the
Remove button.

Each user field from the selected profiles could be
displayed in additional column in Media > Manager from
the Xedio Manager and in the Media Manager tab from the
Xedio CleanEdit.
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1.4

Field

Issue 4.1.D

Description

Default Profile

Allows the selection of a profile, from the list of Selected
Profiles, to be used as default profile when a user will
associate metadata to a media.

The Save button must be pressed to save changes.

EDIT PROFILE ASSOCIATION

When you click the Edit Profile Association button, the Edit Metadata Profile
Table Association window is displayed in the Work area, allowing you to select the
profiles you want to make available to the users.

Description :

Available :

Cup Metadata Profile

Default Profile :  kest

Selected :
Profile 1

kest

The following fields are displayed in the window:

Field Description

Description Automatically filled by the system for the selected profile
with the description text entered at profile creation.

Available Displays the list of existing profiles available for
selection.

Selected Displays the list of profiles which have been selected in

the Available list and added thanks to the Add button.
Profiles can be removed from the Selected list and be
made available in the Available list again by using the
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Field Description

Remove button.

Each user field from the selected profiles could be
displayed in additional column in Tools > Edits Manager
from the Xedio Manager and in the Edit Manager tab from
the Xedio CleanEdit.

Default Profile Allows the selection of a profile, from the list of Selected
Profiles, to be used as default profile when a user will
associate metadata to an edit.

The Save button must be pressed to save changes.
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8.1

8. Playouts

INTRODUCTION

The servers which will be used for payout must be defined and their parameters
must be set in Xedio Manager. They will then be available in the Playout
Organizer application.

Two items are available in the Playouts category. They are detailed in the table
below.

Plapouts

Group Manager

Item Description

Servers Manager Defines hardware setup and parameters for each playout
server.

Group Manager Allows to create groups of playout servers that make

playout channels visible only from specific Playout
Organizer workstations.
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SERVERS MANAGER

INTRODUCTION

When you click the Servers Manager button, the Playout Servers Manager window
is displayed in the Work area, allowing you to define each physical machine to be
used for playout.

+ BB CEWKSaUI7
I2 XSTORE70110

0

CREATING AND CONFIGURING A PLAYOUT SERVER

To create and configure a playout server, complete the following fields and then
click on the Create button.

The playout server name is added to the list on the left side of the window and
“PCX” then “Channel 1" appear underneath, which corresponds to the playout
channel.

Field Description

Label Name you give to the playout server, as it will appear in
the list.

Playout Group List of predefined playout groups. The GLOBAL option

makes the playout server available from all Playout
Organizer workstations.

IP Address IP address of the playout server.

Port (default = 4021) Port used for the playout.

Description Optional text to describe the playout server.

Cardl/2/3 Type of card used. Several cards could be used but it is
not advisable.
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8.2.4

8.3

8.3.1

MODIFYING THE PLAYOUT SERVER PROPERTIES

To modify the properties of a playout server, select it in the list, enter new values
in the relevant fields, and click the Update button.

POSSIBLE ACTIONS WITH CONTEXTUAL MENUS

A contextual menu is available when you select a playout server in the list and
then right-click:

Menu Item Description

Duplicate Creates a new playout server with the same properties.
The term ‘duplicated’ is added next to the new playout
server name.

Delete Deletes the playout server configuration and removes it
from the list.

GROUP MANAGER

INTRODUCTION

The Playout Servers may be grouped together through the Group Manager. This
can be used to group a main server and a backup server. They can then be made
visible only from some predefined Playout Organizer workstations.

When you click the Group Manager button, the Playouts Group Manager window is
displayed in the Work area.

group 1
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CREATING A GROUP OF PLAYOUT SERVERS

To create a group of playout servers, complete the following fields and then click
on the Create button.

The group name is added to the list on the left side of the window.

Field Description

Label Give a name to the group of playout servers.
Description Optional text to describe the group of playout servers.
Playout Servers Select the playout servers to group together.

%g‘} Note
A group of playout channels restricts the amount of available channels
for specific Playout Organizer workstations. There is one default group,
called GLOBAL, that allows a Playout Organizer workstation to “see” all
channels when it is selected.

DELETING A GROUP OF PLAYOUT SERVERS

To be able to delete a group of playout servers, you first need to clear the playout
servers boxes and press the Update button.

Then, right-clicking the group name will show you a contextual menu with the
Delete Group option.
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9. Softwares

INTRODUCTION

The parameters specific to the various applications of the Xedio Suite can be
stored into different profiles. These profiles can then be selected for use by users.

Keyboard shortcuts can also be defined and stored into profiles. These profiles
are linked to the workstation.

Four items are available in the Softwares category. They are detailed in the table

below.

Softwares

Parameter Profiles

®

ard Profiles

o

Fepboard Machines

[tem

Description

Parameter Profiles

Makes it possible to set and store the software
parameters of all applications into profiles.

Keyboard Profiles

Makes it possible to set and store the keyboard key
assignments into profiles.

Keyboard Machines

Allows to assign defined keyboard profiles to
workstations.

Video FX

Allows to set the name and the default parameters for the
transition effects.
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9.2 PARAMETER PROFILES

9.2.1 INTRODUCTION

When you click the Parameter Profiles button, the Softwares Parameter Profiles
window is displayed in the Work area. It is divided into three areas:

er Heademmaker Timelne Tl

Default ¥alue Variant Value

G

o

[ <<l

Nr Area Description

1 Application Selection area This area displays the applications icons
for which it is possible to manage
parameters and profiles.

2 Profile Selection area This area displays the available profiles
that can be managed, relating to the
selected application.

3 Parameters area This area gives the list of parameters.
They can be edited and modified there.

@ Note
Each Xedio application must have been started and have written registry
for its corresponding icons to be available.
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POSSIBLE ACTIONS WITH CONTEXTUAL MENU

A contextual menu is available when an application is selected in the Application
Selection area and you right-click in the Profile Selection Area:

Menu Item Description

New Opens the New Param Profile window where you can
enter a name for the new profile in the Label field.

Modify Opens the Modify Param Profile window allowing to
update the label or description of the selected parameter
profile.

Delete Deletes the selected parameter profile.

iy Note

It is not possible to remove a profile that is
currently in use. An error message will be shown
if this is attempted.

Import from File

Import a parameters profile stored in a .ini format.

In the Open window, select the file that contains the
parameters profile to import.

Import Default

Import a parameters profile stored in a .ini format as the
default parameter profile.

In the Open window, select the file that contains the
parameters profile to import.

Export to File

Exports the selected parameters profile in a readable file
(.ini format).

In the Save As window, select the folder to export the file
to.

Export to Text

Exports the selected parameters profile in a text file
format (.txt format).

In the Save As window, select the folder to export the file
to.
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LIST OF <GENERAL> PARAMETERS

The GENERAL profile gives access to the following lists of parameters (tabs).

General

Auto Refresh Filtering

Can select ClassList
node

Confirmation window
to backup EVS video
server

Default video aspect
ratio

Default high bitrate
video width

Default Proxy Video
Frequency

Default Proxy Video
Resolution

Default video
standard

Default XT Growing
Clip Duration

Grab Still Frame
Folder

Grab Still Frame
Prefix

Notification Center
address

Odd Frame Clipping

When selected: each time a new criterion is added to a
filter, the search is automatically started without pressing
Return or pushing the Search button.

When selected: enables the selection of a class list node
rather than only the deepest sub-items.

When selected: displays a confirmation window before the
backup operation of an EVS video server.

Video Ratio used in thumbnail generation and during
rendering operations

Possible values: 4/3 or 16/9

Free text field to define the default horizontal resolution
for hi-resolution video files (width in pixels)

Default video frequency for Proxy video browsing, editing
and encoding

Default video resolution for Proxy video browsing, editing
and encoding

Video supported by the Dispatcher in the current session
(You cannot mixed PAL and NTSC). This parameter is
also used during rendering to upscale or not the media

Possible values: PAL SD, NTSC drop SD, HD 1080i @50,
HD 720p @50, HD 1080i @59,94, HD 720p @59,94.

Field to define the default duration for XT growing clip.
Field to define the default folder to store grab image file.
Field to define the default prefix for the resulting grab

image file.

Free text field to define the IP address and port number
of the notification center.

When selected: enables clipping on odd frames when
working with P resolution in all players and timelines.

%% Note
This parameter should only be set for full
progressive workflows.
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General

XedioBroker address

XT Clip creation
default clipname

Free text field to define the IP address and port number
of Xedio Broker.

Free text field to define the default clip name when
creating an XT clip.

Audio

Default Input Audio
Track Assignment

Default Rendering
Audio Track
Assignment

Default XT Input
Audio Track
Assignment

Enable 5.1
management

Defines the default audio channel assignment for the
imported media files (other than server clips and encoder
ingests).

The field displays the assignments for 2, 4, 8 and 16
channels configurations separated by a ‘|’ sign.

Refer to the section ‘How to Define New Default Audio
Channel Assignment’ on page 72.

Note

Once the audio track assignment has been defined
in Xedio Importer or AutoFile Importer, these
values will be used instead of the default ones on
the workstation.

Defines the default audio channel for

rendered files.

assignment

The field displays the assignments for 2, 4, 8 and 16
channels configurations separated by a ‘|’ sign.

Refer to the section ‘How to Define New Default Audio
Channel Assignment’ on page 72.

Defines the default audio channel assignment for the
media files (server clips only).The field displays the
assignments for 2, 4, 8 and 16 channels configurations
separated by a ‘|’ sign.

Refer to the section ‘How to Define New Default Audio
Channel Assignment’ on page 72.

Enables the creation of 5.1 tracks in CleanEdit timeline.
The 5.1 audio support in CleanEdit works only with EVS
video server clips. Each track created in the CleanEdit
timeline allows the user to place and manage audio
blocks from server clips, behind which a group of 6 audio
channels are handled.
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How to Define New Default Audio Channel Assignment

It is possible to define new default audio channel assignments.
You will be able to define configurations with:

e up to 8 stereo pairs

e up to 5 stereo pairs and one 5.1 group

e up to 2 stereo pairs and two 5.1 groups.

To do so, proceed as follows.

1. In the Variant Value field, double-click the configuration corresponding to
the selected number of channels.

The Audio Track Assignment window is displayed.

Audia Groups ¢

Caneel

2. Enter a name for the new audio configuration in the Label field.

3. Right-click an audio channel field.

The following contextual menu appears:

ﬁ Add Group ¥ 20

5.1
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4, Select one of the options:
e 2.0
Two audio channels are used

5. Repeat steps 3 and 4 for the remaining channels.

6. If required, you can re-assigned the order of the channels inside a group.
Follow steps 6 and 7.
Right-click an audio channel field.
The following contextual menu appears:

e 2.0:

7. Select one of the options.

Consequently, two channels will have the same name within a group. So the
group is displayed in red.

You will not be able to save the changes until this is solved.
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Automatic Restore

Restore Type

Option list to select the restore type to be used for

automatic restore process.

Possible values:

e Full Restore: restores the whole media

o Partial Restore: restores only the useful section of the
media used in the edit for which a restore is requested.

Import

Imported FileName
Format

Free text field to define the imported filename format for

XDCAM import.

The following items can be used:

%LABEL

%NAME

%CLASSID

%TCIN

%TCOUT

%CLIPTYPE

%USER

%DURATION

%YEAR

%MONTH

%DAY

%HOUR

%MIN

%SEC

%MSEC

%SDYEAR

%SDMONTH

Label given by Xedio user
Clip Name

Class ID

Timecode IN

Timecode OUT

Clip Type, e.g. DV_50i,
P2HD_100i)

Xedio Username
Timecode Duration
Current Year

Current Month
Current Day Number
Current Hour
Current Minute
Current Second
Current Millisecond
Shooting Date - Year

Shooting Date - Month
Number
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Import

Use Long Clip Name

%SDDAY Shooting Date - Day
Number
%GUID Clip GUID

When selected: the long clip name is used as media label.

Vumeter

Bottom level of
Vumeter

Saturation level of
Vumeter

Top level of Vumeter

Warning level of

Field to define the db value of vu-meter bottom level. It is
the audio level difference (in dB) compared the 0 level
(audio level of the source media) and corresponding to
the bottom of the green zone in the audio meters

Field to define the db value of vu-meter saturation level.
It is the audio level difference (in dB) compared to the 0
level (audio level of the source media) and corresponding
to the bottom of the red zone in the audio meters

Field to define the db value of vu-meter top level. It is the
audio level (in dB) of the source media and corresponds
to the top of the red zone in the audio meters.

Field to define the db value of vu-meter warning level.

Vumeter This value corresponds to the beginning of the orange
area in the vu-meter.
s‘g Note
The default values for audio vumeter levels differ in Xedio and in Final
Cut Pro.

It is therefore normal to see the same media reaching the red zone in
Xedio while it is still in the orange zone in FCP.

If you want to have the same audio meter display in both applications,
you can match the audio meter default values in Xedio Manager to the

FCP values.

LIST OF PARAMETERS FOR XEDIO MANAGER

The Xedio Manager profile gives access to the following lists of parameters (tabs).

General

Convert IP to Machine
Name

When selected: the IP address is converted to machine
name for display.

75



Issue 4.1.D

76

Xedio Suite Version 4.1 - User Manual — Xedio Manager
EVS Broadcast Equipment — December 2011

Cefiltermgr

Max Date Interval

Max Result Set Size

Recent Date List

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will
be displayed in the result list after a search filter has
been applied (0 = no limit).

Free text field to define the dates to be displayed in
‘recent dates’ drop-down lists.

Cemediaimport

Enable Audio Track
Assignment Dialog
Enable RTD Import
Enable P2 Import
PlayXTClip
PlayXTTrain

Enable Image Import

Enable Stills Key
Import

Enable Video Import
Enable Wave Import
Enable XDCam Import

Allow XT Import

When select: Enables the display of audio track
assignment dialog tab in the Setup window during an
import.

When select: Allows import of RTD files

When select: Allows import of files with P2 format

When select: Allows server clip to be viewed in a player
When select: Allows server train to be viewed in a player

When select: Allows import of image (stills files)

When select: Allows import of stills with key files

When select: Allows import of video files
When select: Allows import of files with wave format
When select: Allows import of files with XDCam format

When select: Allows import of server clips

Media Manager

LoResGen Media

Server

LoResGen Rendering
Profile

Xedio Media server where the low-resolution media file
shall be (re)generated.

Low-resolution rendering profile used to generate the low-
resolution media file.

Scheduler

Scheduler Published

Default value of the Publish check box when creating a
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Scheduler

Scheduler ReadOnly

record from the Scheduler.
Possible values are: published, not published or previous
state.

When selected: restricts the Scheduler access to read-
only; records cannot be created or modified.

LIST OF PARAMETERS FOR XEDIO CLEANEDIT

The CleanEdit profile gives access to the following lists of parameters (tabs).

An Effects area is displayed in the lower part of the window. Selecting effects
allows the users to use them in CleanEdit. Refer to the Xedio CleanEdit manual
for a description of each effect.

General

Auto Refresh Filtering

Check for missing
hires files

Active Window Color
Show confirmation

dialog

Automatic Edit ID
Generation

Read Only Edit ID

EVS Server Ganging
Type

External Cue Point -
Ranking 0 Color

When selected: each time a new criterion is added to a
filter, the search is automatically started without pressing
Return or pushing the Search button.

When selected, checks for missing hi-res files in the edit
timeline and displays a small yellow triangle over each
missing clip in the timeline.

Option list to select the color used for the rectangle under
the active Player area or Recorder area.

When selected: Shows a confirmation dialog window when
doing delete actions

Enables automatic Edit ID generation and selects the
generation method.

Possible values:

e None

e [DDB: unique in the DB but maybe not across several
DB

o UUID: Universally Unique Identifier (UmID)
When selected: sets the Edit ID property to read-only

Field to enter a value corresponding to a camera ganging
type.

0: XT input cameras

1: IPDirector metadata

2: mixed (first tries IPD metadata then XT input cams)

Color used, in the media bar of the Player, to represent a
log with the default ranking assigned
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General

External Cue Point -
Ranking * Color

External Cue Point -
Ranking ** Color

External Cue Point -
Ranking *** Color

Mandatory Edit On-air
Date

Show ArchiveMgr TAB
Show Devices TAB
Show Edit TAB

Show EditMgr TAB

Show HeaderMaker
TAB

Show Medialmporter
TAB

Show MediaMgr TAB
Show Playout TAB
Show ProjectMgr TAB
Show Export TAB
Show Scheduler TAB
Show
CharacterGenerator
TAB

Show VoiceOver TAB

Show VTR TAB

User Cue Point Color

Color used, in the media bar of the Player, to represent a
log with a ranking * assigned

Color used, in the media bar of the Player, to represent a
log with a ranking ** assigned

Color used, in the media bar of the Player, to represent a
log with a ranking *** assigned

When selected: the on air date of an edit is mandatory

When selected: shows the ArchiveMgr TAB in CleanEdit
When selected: shows the Devices TAB

When selected: shows the Edit TAB

When selected: shows the EditMgr TAB

When selected: shows the Header Maker TAB

When selected: shows the Medialmporter TAB

When selected: shows the MediaMgr TAB
When selected: shows the Playout TAB
When selected: shows the ProjectMgr TAB
When selected: shows the Export TAB
When selected: shows the Scheduler TAB

When selected: shows the CharacterGenerator TAB

When selected: shows the VoiceOver TAB
When selected: shows the VTR TAB

Color used, in the media bar of the Player, to represent a
log entered by the logged user.

Archive

Archive Default
Priority

Field to enter a value corresponding to the default
archive request priority. This value is transmitted when
the system is integrated with DIVA.

Possible values: from 0 to 100, with 0 = disabled, 1 =
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Archive

Archive Hi Res

Archive Low Res

Delete Hi Res

Delete Low Res

Restore Default
Priority

Restore Hi Res
Restore Low Res

Check Locked Media
in Media List

lowest priority and 100 = highest priority.

When selected: archives high resolution files when an
archiving is requested.

When selected: archives low resolution files when an
archiving is requested.

When selected: deletes high resolution files after
archiving.
When selected: deletes Ilow resolution files after
archiving.

Field to enter a value corresponding to the default restore
request priority.

Possible values: from 0 to 100, with 0 = disabled, 1 =
lowest priority and 100 = highest priority.

When selected: restores high resolution files
When selected: restores low resolution files

When selected: allows the user to check for locked media.

Automatic Restore

Restore Priority Edit
Clip

Restore Priority R2B

Field to enter a value corresponding to the Restore
Priority when a clip is dropped in the timeline or when
Edit Play date is modified.

Possible values: from 0 to 100, with 0 = disabled, 1 =
lowest priority and 100 = highest priority.

Field to enter a value corresponding to the Restore
Priority when an Edit is set to Ready to Broadcast.

Possible values: from 0 to 100, with 0 = disabled, 1 =
lowest priority and 100 = highest priority.

Browser

Base for new project

Base for new edit

Base for new clip

Free text field to enter the default base name for a new
project.

Free text field to enter the default base name for a new
edit.

Free text field to enter the default base name for a new
clip.
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Browser

Video standard
selection

When selected: enables the selection of the video
standards.

Cefiltermgr

Allow Change Edit
Properties

Allow Change Media

Properties

Max Date Interval

Max Result Set Size

Recent Date List

When selected: allows the user to change edit properties
in Edit Manager.
media

When selected: allows the wuser to

properties in Media Manager.

change

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will
be displayed in the result list after a search filter has
been applied (0 = no limit).

Free text field to define the dates to be displayed in
‘recent dates’ drop-down lists.

Cemediaimport

Allow to Backup
XTIXS clip

Audio Track
Assignment Dialog
Kmt

P2

PlayXTClip

PlayXTTrain

Stills
Stills Keys
Video
Wave

XDCam

When selected: allows to backup to local storage all Edit
Clip in Direct Access to XT/XS. If this parameter is
selected, the Make Local option is available for Edit.

When selected: Enables the display of audio track
assignment dialog tab in the Setup window during an
import.

When selected: Allows import of RTD files

When selected: Allows import of files with P2 format

When selected:
player

Allows server clip to be viewed in a

When selected: Allows server train to be viewed in a

player

When selected: Allows import of image (stills files)
When selected: Allows import of stills with key files
When selected: Allows import of video files
When selected: Allows import of files with wave format

When selected: Allows import of files with XDCam format
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Cemediaimport
XT When selected: Allows import of server clips
Cerendering2
Available XTNr Free text field to enter a comma-separated list of

Id RTProf Agent

Id Shell Agent

Id To XT Agent

Show To CleanEdit

Show To Device

Show To File

Show To Target

numbers for available EVS video server. If the field is left
empty, all numbers between 1 and 30 are allowed.

Field to enter the DB ID of RTProf agent. If the field is
set to 0, the first available agent with a name containing
‘RTProfAgent’ is fetched from DB.

Field to enter the DB Id of Shell agent. If the field is set
to 0, the first available agent with a name containing
‘ShellAgent' is fetched from DB.

Field to enter the DB Id of ToXT agent. If the field is set
to 0, the first available agent with a name containing
'ToXTAgent' is fetched from DB

When selected: shows the ‘To CleanEdit’ TAB

When selected: shows the ‘To Device’ TAB
When selected: shows the ‘To File’ TAB

When selected: shows the ‘To Target’ TAB

Cg

Enable Import Picture

Enable Save As
Template

When selected: enables the Import Picture button.

When selected: enables the Save as template button.

HeaderMaker

Template Path

Free text field to enter the path to HeaderMaker template.

Player

Auto Clip IN

Auto Clip OUT

Amount of fields before the entry point of a clip when
using the auto-clipping tool (Alt+Space bar).

Amount of fields after the out point of a clip when using
the auto-clipping tool (Alt+Space bar).
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Player

Browsing Interval
Accuracy

Enable Deinterlace
Menu

Jog Audio Threshold
HI

Jog Audio Threshold
LO

Jog Range HI
Jog Range LO

PrevNextX

Shift Speed Max

Speed Max

XT Clip Creation Time

Tolerance

XT Stream Creation
Time Tolerance

XT Train Only View
Enable

Field to enter the interval, in msec, in which the media
player browsing tries to be frame accurate.

WARNING: high values require a high bandwidth.

When selected: enables the Deinterlacer menu (hi-res
mode only).

Field to enter the jog browsing speed limit for the audio
to be decoded in hi-res.

Field to enter the jog browsing speed limit for the audio
to be decoded in lo-res.

Field to enter the jog range in hi-res.
Field to enter the jog range in lo-res.

Field to enter the number of fields to jump when Alt key
is used with Prev and Next buttons.

Field to enter the speed rate for super fast forward and
rewind tools when used together with the Shift key.

Field to enter the speed rate for fast forward and fast
rewind tools.

Field to enter the tolerance value (in seconds) towards
the creation time between two sibling XT clips.

Field to enter the tolerance value (in seconds) towards
the creation time between two sibling streams.

When selected: the clip creation on XT train is disabled.

Recorder

Browsing Interval
Accuracy

Enable Deinterlace
Menu
PreRoll

PrevNextX

RollBoth

Field to enter the interval, in msec, in which the timeline
browsing tries to be frame accurate.

WARNING: high values require a high bandwidth.

When selected: enables the
mode only).

Deinterlacer menu (hi-res
Field to enter the Preroll time, in fields, used to play
previous/next transition

Field to enter the number of fields to jump when Alt key
is used with Prev and Next buttons.

When selected: enables the left roller and right roller
tools.
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Recorder

RollLeft When selected: enables the left roller tool

RollRight When selected: enables the right roller tool

RollTurn When selected: enables the clip roller tool

Scheduler

Read Only When selected: restricts the Scheduler access to read-
only; records cannot be created or modified.

Timeline

Audio Auto FX

Audio Effects

Audio Fade IN Dur

Audio Fade IN Pos

Audio Fade OUT Dur

Audio Fade OUT Pos

Audio Level Adjust

Audio Level Max

Audio X Fade Dur

Audio X Fade Pos

Block Font Height

When selected: enables automatic audio transition effect.

When selected: enables graphical audio transition effects
adjustments when zooming audio tracks

Field to enter the duration, in fields, of the audio fade
effect at the IN point. This will be displayed in the “fx”
dialog box, “Audio fade” tab.

Option list to select the position of the audio fade effect
at the IN point. This will be displayed in the “fx” dialog
box.

Possible values: None, Before OUT, Centered, After OUT.

Field to enter the duration, in fields, of the audio fade
effect at the OUT point. This will be displayed in the *“fx”
dialog box, “Audio fade” tab.

Option list to select the position of the audio fade effect
at the OUT point. This will be displayed in the “fx" dialog
box.

Possible values: None, Before OUT, Centered, After OUT.

Field to enter the default audio level value to be

displayed in the FX dialog box.

Field to enter the maximum audio level adjustment value
to be displayed in the FX dialog box.

Field to enter the default audio fade duration to be
displayed in the “fx” dialog box, “Audio fade” tab.

Option list to select the audio cross fade position.
Possible values: None, Before OUT, Centered, After OUT.

Field to enter the text font size in timeline block.
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Timeline

Block Font Name
Can Accelerate

Clips Move

Clips Move Sensibility

Color Block Width

Default Audio Trans
FX

Default Video Trans
FX

Fast Motion Clip HR

Fast Motion Clip LR

Fx Tab Audio Fade

FX Tab Audio Level

FX Tab Color Ins

Fx Tab Video Fade

Guardband Frames

Graphics Insert
Duration

Magnet Pixels

Option list to select the text font name in timeline block.
When selected: enables fast motion.

Field to enter the number of fields to shift the selected
clips, to the left or to the right, when used in combination
with + or - key.

Field to enter the mouse sensitivity value when selecting
and moving blocks inside the timeline.

Field to enter the size of the color area within timeline
blocks.
Option list to define the default audio transition effect.

Possible values: None, Fade OUT, Fade IN, Cross Fade.

Option list to define the default video transition effect.
Possible values: Mix, Wipe, Border Wipe, Dip to Color.
Option list to select the transcoding codec used for the
rendering of hi-res Fast Motion Clip.

Possible values: list of codecs available with the current
release package.

Option list to select the transcoding codec used for the
rendering of lo-res Fast Motion Clip.

Possible values: list of codecs available with the current
release package.

When selected: enables the Audio Effect tab in the Fx
dialog.box.

When selected: enables the Audio Level Adjustment tab in
the FX dialog box.

When selected: enables the Color Clip Tool tab in the FX
dialog box.

When selected: enables the video Fade tab in the FX
dialog box.

Note: this is not supported.

Field to enter the minimum duration value when adjusting
clip duration using the rollers.

Field to enter the default duration for inserted graphics.

Field to enter the sensitivity value of the magnetic effect
during drag-and-drop operations on timeline clips.
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Timeline

Max Display DB

Max Fast Motion
Speed

Reset To Default

Show Audio Matrix
Buttons

Show Default Audio
Channel Buttons
Show TC In Out
Tag_External
Graphics
Tag_Logo Insertion

Tag_Viz

Tag Default Duration

Tag Label List

Tag Properties

Use Tag Labels

Use Tag Templates

Video Auto FX

Video Color Dur

Video Color Ins

Video Effects

Field to enter the maximum displayed value for audio
level.

Field to enter the maximum allowed value in the Fast
Motion speed dialog box (in percent) if the
‘CanAccelerate’ parameter is set to 1.

When selected: resets the toolbar when creating a new
edit

When selected: displays the Audio Matrix button in the
CleanEdit interface.

When selected: displays the Default Audio Channel
buttons.

When selected: displays the timecodes (IN and OUT) in
the timeline blocks.

When selected: enables the External Graphics tab in tag
properties dialog box.

When selected: enables the Logo Insertion tab in tag
properties dialog box.

When selected: enables the Viz tab in tag properties
dialog box.

Field to enter the default tags duration.

When selected: uses label list for tags.

Otherwise, free text is used.

When selected: enables the Tag Properties dialog box
and the Add Tag option from contextual menu.

When selected: enables the Label field in the External
Graphics tab of the Tags dialog box.

When selected: enables the Template field in the External
Graphics tab of the Tags dialog box.

When selected: enables automatic video transition effect.

Field to enter the length of the clip created with the ‘color
insertion tool’.

Option list to select the color of the clip created with the
‘color insertion tool’.
video transition effects

When selected: enables

adjustments.
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TL Buttons

Afx

Align Left

Align Right

Blank Clear

Blank Delete

Blank Fill

Cue

Clip Selector

Color Insert

Extend

Extend Slow

Extend Still

Fx

In Out Delete

Invert

Mark Clip

Mark IN

Mark OUT

Mark Reset

When selected: displays the AFX button above the
timeline.

When selected: displays the Align Left button above the
timeline.

When selected: displays the Align Right button above the
timeline.

When selected: displays the Blank Clear button above
the timeline.

When selected: displays the Blank Delete button above
the timeline.

When selected: displays the Blank Fill button above the
timeline.

When selected: displays the Cue Tool button above the
timeline.

When selected: displays the Select All button
(after/before nowline) above the timeline.

When selected: displays the Color Insert button above
the timeline.

When selected: displays the Extend button above the
timeline.

When selected: displays the Extend Slow button above
the timeline.

When selected: displays the Extend Still button above
the timeline.

When selected: displays the FX button used to call the FX
the dialog box above timeline.

When selected: displays the In Out Delete button above
the timeline.

When selected: displays the A/B button above the
timeline.

When selected: displays the Mark Clip button above the
timeline.

When selected: displays the Mark In button above the
timeline.

When selected: displays the Mark Out button above the
timeline.

When selected: displays the Mark Reset button above the
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TL Buttons
timeline.

Move Frame When selected: enables the Move Frame edit zone.

Overwrite When selected: displays the Insert/Overwrite button
above the timeline.

Rendering When selected: displays the Rendering button above the
timeline.

Split When selected: displays the Clip Split button above the
timeline.

Vix When selected: displays the VFX button above the
timeline.

TL Colors Option list to select the...

Audio Block Audio block color

Audio Block With FX
Audio Hatching
Audio Text

Audio Trace Color
Drag Audio Trace
Drag Video Trace
Mark IN

Mark OUT

NowLine

Rendered Video Block
Selected Blocks

Sync Block

Video Block
Video Block With FX
Video Hatching

Video Text

Color for audio block with FX

Audio block hatching color

Audio block text color

Audio level color

Color for the audio level when adjusting
Color for the video transition duration when adjusting
Mark IN line color

Mark OUT line color

Nowline color

Rendered video block color

Selected timeline blocks color

Color for audio block which has been moved out of sync
with its associated video.

Video block color
Color for video block with FX
Video block hatching color

Video block text color
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TL Colors

Option list to select the...

VO Text

VO With Attenuation

VO Without
Attenuation

VO block text color

Color for VO block with attenuation

Color for VO block without attenuation

Voiceover

Attenuation Auto

Attenuation DB

Attenuation Fade

Attenuation Pos

PreRoll

Text Mask

When selected: enables the voice over auto-dim mode
(automatic attenuation of all the audio channels from the
same output than the voice over for the voice over
duration).

Field to enter the value (DB) for automatic audio level
attenuation of audio channels for the voice over duration.

Field to enter the fade length, in fields, to reach the audio
level set with AttenuationDB.

Option list to select the Attenuation Fade position.

Possible values are: None, before cut, centered, after
cut.

Field to enter the Preroll time, in fields, used to play
voice over.

Field to enter the voice over default base name.

LIST OF PARAMETERS FOR XEDIO INGEST

The Xedio Ingest profile gives access to the following lists of parameters (tabs).

General

Default Media Class

Crash published

Option list to select the Media class to be used by default
during ingest.

Possible values: Media classes defined under Media >
Class Manager.

Option list to define whether a crash record will
automatically be published.
Possible values: Not Published, Published, Previous

State.
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Scheduler

Scheduler published

Option list to define the publish state of the ingest from
the Scheduler in Xedio Ingest.

Possible values: Not Published, Published, Previous
State.

VTR

VTR published

Option list to define the default value of the Publish box
when creating a record from VTR.

Possible values: Not Published, Published, Previous
State.

LIST OF PARAMETERS FOR XEDIO PLAYOUT ORGANIZER

The Playout Organizer profile gives access to the following lists of parameters

(tabs).

Cefiltermgr

Max Date Interval

Max Result Set Size

Recent Date List

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will
be displayed in the result list after a search filter has
been applied (0 = no limit).

Free text field to define the dates to be displayed in
‘recent dates’ drop-down lists.

Playout Organizer

Automatic restore
priority

Force Approval

Hide Start on time

When adding an ARCHIDEL clip to a playlist, an
automatic restore is launched if the broadcast date and
time is foreseen within 24 hours.

This parameter sets the priority of the restore.

Possible values: from 0 to 100, with 0 = disabled, 1 =
lowest priority and 100 = highest priority.

When selected: forces DB objects to be approved before
their insertion into a playlist.

When selected: hides the Start on-time button.
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LIST OF PARAMETERS FOR XEDIO BROWSE

The Xedio Browse profile gives access to the following lists of parameters.

General

Text Mask Field to enter the default base name for a new virtual
media.

Player

Jog Range HI Field to enter the jog range in hi-res.

Jog Range LO Field to enter the jog range in lo-res.

PrevNextX Field to enter the number of fields to jump when Alt key
is used with Prev and Next buttons.

Shift Speed Max Field to enter the speed rate for super fast forward and
rewind tools when used together with the Shift key.

Speed Max Field to enter the speed rate for fast forward and fast

rewind tools.

LIST OF PARAMETERS FOR XEDIO BROWSE (VC)

The Xedio Browse (VC) profile gives access to the following lists of parameters.

General

Text Mask Field to enter the default base name for a new virtual
media.

Player

Jog Range HI Field to enter the jog range in hi-res.

Jog Range LO Field to enter the jog range in lo-res.

PrevNextX Field to enter the number of fields to jump when Alt key
is used with Prev and Next buttons.

Shift Speed Max Field to enter the speed rate for super fast forward and
rewind tools when used together with the Shift key.

Speed Max Field to enter the speed rate for fast forward and fast

rewind tools.
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9.2.10 LIST OF PARAMETERS FOR XEDIO APPROVAL

9.2.11

The Xedio Approval profile gives access to the following lists of parameters.

AutomaticRestore

Restore Priority Edit
Clip

Field to enter a value corresponding to the Restore
Priority when an edit play date is modified.

Possible values: from 0 to 100, with 0 = disabled, 1 =
lowest priority and 100 = highest priority.

Player

Enable Deinterlace
Menu

Jog Range HI
Jog Range LO

Play LoRes if HiRes
is offline

Video Output Type

Output Video
Definition

When selected: enables the deinterlacer menu (hi-res
files only).

Field to enter the jog range in hi-res.
Field to enter the jog range in lo-res.

Play the low resolution file if the high resolution file is not
available (e.g. archived).

Possible values: 1 = enabled, 0 = disabled.

Option list to select the video output type.

Possible values: VGA, PCX1/PCX2, PCX3.

Option list to select the default video output mode for
VGA and PCX3.

Possible values: SD, HD1080i.

LIST OF PARAMETERS FOR XEDIO IMPORTER

The Xedio Importer profile gives access to the following list of parameters.

Cemediaimport

Audio Track
Assignment Dialog

Kmt
P2

PlayXTClip

PlayXTTrain

When selected: enables the display of audio track
assignment dialog tab in the Setup window during an
import.

When selected: allows import of RTD files.

When selected: allows import of files with P2 format

When selected: allows server clip to be viewed in a
player.

When selected: allows server train to be viewed in a
player.
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Cemediaimport

Stills

Stills Keys
Video
Wave
XDCam
XDCamEX

XT

When selected: allows import of image (stills files).
When selected: allows import of stills with key files.
When selected: allows import of video files.

When selected: allows import of files with wave format.
When selected: allows import of files with XDCam format.
When selected: allows import from XDCamEX device.

When selected: allows import of server clips.

LIST OF PARAMETERS FOR XEDIO EXPLORER

The Xedio Explorer profile gives access to the following lists of parameters.

General

Allow to MOS-publish
exported edits

Automatic Edit ID
Generation

Read-Only Edit ID

Program Class to set
when checking MOS
published

Is Program Class set
when checking MOS
published read-only?

When selected: sends the item to the MOS as soon as it
is exported ‘To Edit’.

Enables automatic Edit ID generation and selects the
generation method.
Possible values:

e None

e [DDB: unique in the DB but maybe not across several
DB

e UUID: Universally Unique Identifier (UmID)
When selected: sets the edit ID property to read-only.

Option list to select the Program Class to be used by
default when the exported items are published to the MOS
(‘Allow to MOS-publish exported edits’ option selected).

Possible values: Program classes defined under Tools >
Program Class Manager.

When selected: sets the Program Class even if the ‘Read-
only Edit ID’ option has been selected.

Cefiltermgr

Allow Change Edit
Properties

When selected: allows the user to change the edit
properties in Edit Manager.
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Cefiltermgr

Allow Change Media

Properties

Max Date Interval

Max Result Set Size

Recent Date List

When selected: allows the user to change the media
properties in Media Manager.

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will
be displayed in the result list after a search filter has
been applied (0 = no limit).

Free text field to define the dates to be displayed in
‘recent dates’ drop-down lists.

LIST OF PARAMETERS FOR XEDIO CUTTER

The Xedio Cutter profile gives access to the following lists of parameters.

General

Allow to MOS-publish
exported edits

Automatic Edit ID
Generation

Read-Only Edit ID

Program Class to set
when checking MOS
published

Is Program Class set
when checking MOS
published read-only?

When selected: sends the storyboard to the MOS as soon
as it is exported ‘To Edit’ from Xedio Cutter.

Enables automatic Edit ID generation and selects the
generation method.

Possible values:

e None

e [DDB: unique in the DB but maybe not across several
DB

e UUID: Universally Unique Identifier (UmID)
When selected: sets the edit ID property to read-only.

Option list to select the Program Class to be used by
default when the exported storyboards are published to
the MOS (‘Allow to MOS-publish exported edits’ option
selected).

Possible values: Program classes defined under Tools >
Program Class Manager.

When selected: sets the Program Class even if the '‘Read-
only Edit ID’ option has been selected.
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Cefiltermgr

Allow Change Media
Properties

Max Date Interval

Max Result Set Size

Recent Date List

When selected: allows the user to change the media
properties in Media Manager.

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will
be displayed in the result list after a search filter has
been applied (0 = no limit).

Free text field to define the dates to be displayed in
‘recent dates’ drop-down lists.

Player

Auto Clip IN Amount of fields before the entry point of a clip when
using the auto-clipping tool (Alt+Space bar).

Auto Clip OUT Amount of fields after the out point of a clip when using
the auto-clipping tool (Alt+Space bar).

Jog Range HI Field to enter the jog range in hi-res.

Jog Range LO

PrevNextX

Shift Speed Max

Speed Max

XT Clip Creation Time

Tolerance

XT Stream Creation
Time Tolerance

Field to enter the jog range in lo-res.

Field to enter the number of fields to jump when Alt key
is used with Prev and Next buttons.

Field to enter the speed rate for super fast forward and
rewind tools when used together with the Shift key.

Field to enter the speed rate for fast forward and fast
rewind tools.

Field to enter the tolerance value (in seconds) towards
the creation time between two sibling XT clips.

Field to enter the tolerance value (in seconds) towards
the creation time between two sibling XT streams.

Storyboard

Allow Edits in MOS
Brw

Allow Export to Avid
Allow Export to File

Allow Export to

Allows drag-and-drop operations of edits

When selected, allows to export the storyboard to AVID.
When selected, allows to export the storyboard as a file.

When selected, allows to export the storyboard to a
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Storyboard
Playlist playlist.
Allow Voice Over Allows to insert voiceover text

How TO EDIT A PARAMETER PROFILE

To edit the parameters values of a profile, proceed as follows:

1.

In the Application Selection area, select the application in which a
parameter profile should be edited.

Select the profile in the Profile Selection area.

In the Parameters area, edit the desired parameters in the Variant Values
column

e by selecting or clearing the box corresponding to a parameter (check box)
e by adding the required value (field to enter a value)

e by selecting the required value (option list)
The default values can be changed by editing the <default> profile.

Click the Save button to save the selected profile.

A dialogue box will show a successful update:

X

o Faram profile n*2 ully updated

Note

The modifications from the <default> profile are highlighted in the
Parameters area.
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KEYBOARD PROFILES

INTRODUCTION

When you click the Keyboard Profiles button, the Softwares Keyboard Profiles
window is displayed in the Work area. It is divided into three areas such as the
Softwares Parameter Profiles window. Refer to section 9.2 ‘Parameter Profiles’ on
page 68 for more information.

Gereral | Browser Plaper Fec Timeline  Playout

Label Delault Keyboard Function(s) Wanant Keyboard Function(s)

9.3.2

9.3.3

96

The keyboard profiles editor manages the key assignments for the software
applications within the Xedio suite.

POSSIBLE ACTIONS WITH CONTEXTUAL MENU

A contextual menu is available when an application is selected in the Application
Selection area and you right-click in the Profile Selection Area. Refer to section
9.2.2 ‘Possible Actions with Contextual Menu’ for the parameters profiles on page
69 for a description of the various options.

How TO EDIT A KEYBOARD SHORTCUT

To edit a keyboard shortcut, proceed as follows:
1. Select the application for which you want to edit the keyboard shortcut.
2. Select the profile to be edited.

3. Double click on an existing shortcut definition in the Variant Keyboard
Functions column.

4, Enter the new shortcut in the Key Assignator dialog box. It can be a
combination with SHIFT/ALT/CTRL, etc...

5. Press the OK button

6. Press the Save button at the bottom of the window to save the selected
profile.
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%g) Note
The <Default> profile can also be edited.

9.3.4 LiST OF XEDIO CLEANEDIT KEYBOARD KEYS ASSIGNMENTS

The CleanEdit keyboard profile gives access to the following lists of parameters

(tabs).

General

Player Focus Sets focus on player window
Player Full Screen Zoom player window to full screen
Recorder Focus Sets focus on recorder window

Recorder Full Screen Zoom recorder window to full screen

Redo Redoes last operation

Undo (a) Undoes last operation

Undo (b) Undoes last operation (secondary shortcut)
Browser

Delete Deletes selected item

Duplicate Current Edit Creates a duplicate of selected edit

Insert Creates a new project/edit

Player

Auto Aspect Ration Automatically applies the default aspect ratio

AutoClip Creates a quick clip with properties set in the profile

Drop In Drops the clip, defined in the player, after the timeline IN
point

Drop NowLine Drops the clip, defined in the player, after the timeline
"nowline”

Drop Out Drops the clip, defined in the player, before the timeline
OUT point

Audiol monitoring (a) Toggle monitoring of the player audio stereo 1
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Player

Toggle Audiol
Selection (a)

Audio2 monitoring (a)

Toggle Audio2
Selection (a)

Audio3 monitoring (a)

Toggle Audio3
Selection (a)

Audio4 monitoring (a)

Toggle Audio4
Selection (a)

Audio5 monitoring (a)

Toggle Audio5
Selection (a)

Audio6 monitoring (a)

Toggle Audio6
Selection (a)

Audio7 monitoring (a)

Toggle Audio7
Selection (a)

Audio8 monitoring (a)

Toggle Audio8
Selection (a)

Toggle Video (a)

Fast Forward

Fast Rewind

Goto End
Goto IN
Goto OUT
Goto Start

Grab Still Frame

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Goes fast forward the media in player window (if focus is

selection of the player audio stereo 1

monitoring of the player audio stereo 2

selection of the player audio stereo 2

monitoring of the player audio stereo 3

selection of the player audio stereo 3

monitoring of the player audio stereo 4

selection of the player audio stereo 4

monitoring of the player audio stereo 5

selection of the player audio stereo 5

monitoring of the player audio stereo 6

selection of the player audio stereo 6

monitoring of the player audio stereo 7

selection of the player audio stereo 7

monitoring of the player audio stereo 8

selection of the player audio stereo 8

the selection of the player video track

set to player)

Fast rewinds the media in player window (if focus is set to
player)

Jumps to end of the clip or media

Jumps to the IN point

Jumps to the OUT point

Jumps to beginning of the clip or media

Grabs a still of the current frame
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Player

Insert CuePoint

Mark IN (a)

Mark IN (b)

Mark OUT (a)

Mark OUT (b)

Next Frame (a)
Next Frame (b)

Next CuePoint

Next Ganged Camera

Next X Frames (a)

Next X Frames (b)

Play/Stop

PlayClip
PlayClip_loop

Play Forward

Play Reverse
PlayNearLive
Previous Frame (a)
Previous Frame (b)
Previous CuePoint
Previous Ganged
Camera

Previous X Frames (a)

Inserts a cue point (needs a number to be typed + "enter"
for a timeline cue point)

Sets clip IN point to current nowline position

Sets clip IN point to current nowline position (secondary
shortcut)

Sets clip OUT point to current nowline position

Sets clip OUT point to nowline

(secondary shortcut)

current position

Goes to next frame
Goes to next frame (secondary shortcut)

Goes to next cue point in Player. Goes to next transition
in timeline

Goes to the next ganged camera

Jumps to next x frames (x is defined in the software
profile)

Jumps to next x frames (x is defined in the software
profile) (secondary shortcut)

Starts/stops loaded media in the Player window from the
current position

Plays the clip to OUT point once

Plays the clip to OUT in loop mode

Plays forward at various speeds

Plays reverse at various speeds

Near live plays a recording media

Jumps to previous frame

Jumps to previous frame (secondary shortcut)

Goes to previous cue point in Player. Goes to previous
transition in timeline

Goes to the previous ganged camera

Jumps to previous x frames (x is defined in the software
profile)
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Player

Previous X Frames (b)

Toggle All Audio

Rewind 25%
Rewind 33%
Rewind 50%
Rewind 100%
Rewind 150%
Rewind 200%
Rewind 400%
Forward 25%
Forward 33%
Forward 50%
Forward 100%
Forward 150%
Forward 200%
Forward 400%

Stop

Change Aspect Ration

Jumps to previous x frames (x is defined in the software
profile)

Toggle all player audio
Rewinds at 25% speed
Rewinds at 33% speed
Rewinds at 50% speed
Rewinds at 100% speed
Rewinds at 150% speed
Rewinds at 200% speed
Rewinds at 400% speed
Goes forward at 25% speed
Goes forward at 33% speed
Goes forward at 50% speed
Goes forward at 100% speed
Goes forward at 150% speed
Goes forward at 200% speed
Goes forward at 400% speed
Stops playing the media

Changes the aspect ratio

Playout

Goto IN Jumps to the IN point

Next Frame Jumps to next frame
Play/Stop Starts/stops to play the media

Previous Frame

Rewind 25%

Rewind 33%

Rewind 50%

Jumps to previous frame
Rewinds at 25% speed
Rewinds at 33% speed

Rewinds at 50% speed
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Playout

Rewind 100% Rewinds at 100% speed
Rewind 150% Rewinds at 150% speed
Rewind 200% Rewinds at 200% speed
Rewind 400% Rewinds at 400% speed
Forward 25% Goes forward at 25% speed
Forward 33% Goes forward at 33% speed
Forward 50% Goes forward at 50% speed
Forward 100% Goes forward at 100% speed
Forward 150% Goes forward at 150% speed
Forward 200% Goes forward at 200% speed
Forward 400% Goes forward at 400% speed
Stop Stops the recorder

Toggle Stop Warning Selects or clears the Stop Warning option in the Playout
tab. This option displays a warning message when the
Stop button is clicked.

Recorder

Auto Aspect Ratio Automatically applies the default aspect ratio
Audiol monitoring (a) Toggle monitoring of the player audio stereo 1
Audio2 monitoring (a) Toggle monitoring of the player audio stereo 2
Audio3 monitoring (a) Toggle monitoring of the player audio stereo 3
Audio4 monitoring (a) Toggle monitoring of the player audio stereo 4
Audio5 monitoring (a) Toggle monitoring of the player audio stereo 5
Audio6 monitoring (a) Toggle monitoring of the player audio stereo 6
Audio7 monitoring (a) Toggle monitoring of the player audio stereo 7
Audio8 monitoring (a) Toggle monitoring of the player audio stereo 8
Goto End Jumps to the end of the edit

Goto Next Transition Jumps to next transition (in regard to the selected tracks)
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Recorder

Goto Next Transition

(b)

Goto Previous
Transition

Goto Previous
Transition (b)

Goto Start
Next Frame (a)
Next Frame (b)

Next X Frames (a)

Next X Frames (b)

Play/Stop
Play Forward

Play from Next
Transition

Preview Previous
Transition

Play Reverse

Preload

Previous Frame (a)
Previous Frame (b)

Previous X Frames (a)

Previous X Frames (b)

Apply Roll Changes

Roll left and right

Cancel Roll Changes

Jumps to next transition (in regard to the selected tracks)
(secondary shortcut)

Jumps to previous transition (in regard to the selected
tracks)

Jumps to previous transition (in regard to the selected
tracks) (secondary shortcut)

Jumps to the beginning of the edit
Jumps to next frame
Jumps to next frame (secondary shortcut)

Jumps to next x frames (x is defined in the software
profile)

Jumps to next x frames (x is defined in the software
profile) (secondary shortcut)

Starts/stops loaded edit in recorder window
Plays forward at various speeds

Plays from next transition (in regard to the selected
tracks) (with Preroll)

Previews previous transition (in regard to the selected
tracks) (with Preroll)

Plays reverse at various speeds

Preloads the current edit in the recorder window, as well
as effect defined at this point

Jumps to previous frame
Jumps to previous frame (secondary shortcut)

Jumps to previous x frames (x is defined in the software
profile)

Jumps to previous x frames (x is defined in the software
profile) (secondary shortcut)

Applies the changes made with the roller tools in the
timeline

Adds one frame to the right part of the left clip and
removes one frame to the left part of the right clip of a
transition

Cancels the changes made with the roller tools



Xedio Suite Version 4.1 - User Manual — Xedio Manager Issue 4.1.D
EVS Broadcast Equipment — December 2011

Recorder

Roll Left Adds one frame to the left part of the right clip of a
transition, from its source file

Match Frame Loads the current file and picture in the player window
from its original media

Match XT Train Loads, in the Player, the EVS Server record train that
contains the image displayed in the Recorder.

Roll Right Adds one frame to the right part of the left clip of a
transition, from its source file

Roll Clip Adds one frame at the beginning and remove one frame at
the end of a selected clip

Forward 25% Goes forward at 25% speed

Forward 33% Goes forward at 33% speed

Forward 50% Goes forward at 50% speed

Forward 100% Goes forward at 100% speed

Forward 150% Goes forward at 150% speed

Forward 200% Goes forward at 200% speed

Forward 400% Goes forward at 400% speed

Rewind 25% Rewinds at 25% speed

Rewind 33% Rewinds at 33% speed

Rewind 50% Rewinds at 50% speed

Rewind 100% Rewinds at 100% speed

Rewind 150% Rewinds at 150% speed

Rewind 200% Rewinds at 200% speed

Rewind 400% Rewinds at 400% speed

Stop Stops the recorder

Change Aspect Ratio  Changes the aspect ratio

Timeline

AddTag Adds a tag to the timeline

Call Audio Clip FX Calls audio clip effects dialog box
dialog
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Timeline

Call Audio Transition
FX dialog

Blank Clear

Move Clips + 1 frame
left

Move Clips + X frame
left

Move Clips + 1 frame
right

Move Clips + X frame
right

Copy
Cut

Delete (AV lift)

Delete Clip(s)

Delete and Shift (AV
extract)

Goto IN
Goto OUT

In / Out Delete

Mark IN (b)

Mark IN (a)

Mark OUT (b)

Mark OUT (a)

MarkSelection

Calls audio transition effects dialog box

Shifts all timeline clips, that are situated after the nowline,
to left, removing common holes, in regard to the selected
tracks

Moves selected clips one frame to the left

Moves selected clips x frame(s) to the left (x is defined in
the software profile)

Moves selected clips one frame to the right

Moves selected clips x frame(s) to the right (x is defined
in the software profile)

Copies selected clips to the clipboard

Removes selected clips

Removes selected clips from the timeline and do not shift
the following clips to the left. This behaves like the Delete
& Clear button.

Removes selected clips from the timeline. The result will
depend on whether the Delete & Clear button or the
Delete & Shift button is activated in the timeline.
Removes selected clips from the timeline and shift the
following clips to the left. This behaves like the Delete &
Shift button.

Sets the nowline to the timeline IN point

Sets the nowline to the timeline OUT point

Removes the timeline content between the IN and OUT
points in regard to the selected tracks

Places IN point to the current nowline position

Places IN point to the current nowline position (secondary
shortcut)

Places OUT point to current nowline position

Places OUT point to current nowline position (secondary
shortcut)

Sets the timeline IN point to the beginning of the first clip
and the OUT point to the end of the last selected clip.
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Timeline

Next Ganged Camera
Paste

Previous Ganged
Camera

Remove IN

Remove In / Out
Remove OUT

Select All Clips

Select All Clips After
Nowline

Select All Clips Before

Nowline

Split

Toggle All Audio

Toggle Audiol (a)
Toggle Audio2 (a)
Toggle Audio3 (a)
Toggle Audio4 (a)
Toggle Audio5 (a)

Toggle Blank Fill
On/Off

Toggle Insert
Overwrite mode

Toggle Video (a)

Call Video Clip FX
dialog

Call Video Transition
FX dialog

Replaces the selected clip by the corresponding clip from
the next ganged camera

Pastes clipboard content to the timeline, after nowline
position

Replaces the selected clip by the corresponding clip from
the previous ganged camera

Clears timeline IN point
Clears timeline IN and OUT points
Clears timeline OUT point

Selects all timeline clips in regard to the selected tracks
and to the timeline IN and OUT points

Selects all clips below and after the current nowline
position in regard to the selected tracks

Selects all clips below and before the current nowline
position in regard to the selected tracks

Cuts the clips below the nowline in two pieces in regard to
the selected tracks

Toggle the selection of all timeline audio tracks
Toggle the selection of the stereo track 1
Toggle the selection of the stereo track 2
Toggle the selection of the stereo track 3
Toggle the selection of the stereo track 4
Toggle the selection of the stereo track 5

Toggle Blank Fill mode (on/off)

Toggle Insert and Overwrite modes

Toggle the selection of the video track

Calls video clip effects dialog box

Calls video transition effects dialog box
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Voiceover
Mark IN Sets a marker for the start of voice over
Mark OUT Sets a marker for the end of voice over

Play from IN of last VO

Play from OUT of last
VO
Start Record

Stop Record

Plays from the beginning of the last voice over record
(with Preroll)

Plays from the end of the last voice over record (with
Preroll)

Starts the recording of voice over

Stops the recording of voice over

LIST OF XEDIO PLAYOUT ORGANIZER KEYBOARD KEYS

ASSIGNMENTS

The Xedio Playout Organizer keyboard profile gives access to the following list of
parameters.

General

Cue Cues the media

Next Skips the playout of the media and plays the next one
Play Plays the media

Prev Skips the playout of the media and plays the previous one
Stop Stops the playout of media

ToggleLoop Toggles the play mode between loop and normal
ToggleRes Toggles resolution between lo-res and hi-res within the

Playlist pane of the Playout Organizer

LIST OF XEDIO BROWSE AND XEDIO BROWSE (VC)
KEYBOARD KEYS ASSIGNMENTS

The Xedio Browse and the Xedio Browse (VC) keyboard profiles gives access to
the following lists of parameters.

Player
FastFwd Goes fast forward
FastRew Fast rewinds



Xedio Suite Version 4.1 - User Manual — Xedio Manager
EVS Broadcast Equipment — December 2011

9.3.7

Issue 4.1.D

Player

Goto End Jumps to last picture

Goto IN Goes to IN point

Goto OUT Goes to OUT point

Goto Start Jumps to first picture

Next Jumps to next frame

NextX Jumps to next x (preset) frames

Play PIay;/Stops loaded media in Player window from current
position

Play RTE Near-live plays a recording media/clip

Prev Jumps to previous frame

PrevX Jumps to previous x (preset) frames

Stop Stops the player

Properties

Del Marks Removes IN and OUT points

Mark IN Sets IN point of new virtual media/clip

Mark OUT Sets OUT point of new virtual media/clip

Save Saves virtual media/clip in database

SB Mark Sets new virtual media/clip IN point (the first time the key

is pressed) and OUT point (the second time the key is
pressed)

LIST OF XEDIO CUTTER KEYBOARD KEYS ASSIGNMENTS

The Xedio Cutter
parameters.

keyboard profile gives access to

the following lists of

General

Player Focus
Player Full Screen

Recorder Focus

Sets the focus on player
Sets the player to full screen

Sets the focus on recorder
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General

Recorder Full Screen

Sets the recorder to full screen

Redo Redoes the last action

Undo (a) Undoes the last action

Undo (b) Undoes the last action (secondary shortcut)
Player

Auto Clip Sets clip IN and OUT points on the fly

Toggle Audiol (a)

Toggle Audiol (b)

Toggle Audio2 (a)

Toggle Audio2 (b)

Toggle Audio3 (a)

Toggle Audio3 (b)

Toggle Audio4 (a)

Toggle Audio4 (b)

Toggle Video (a)
Toggle Video (b)
Fast Forward
Fast Rewind
Goto End

Goto IN

Goto OUT

Goto Start
Insert Cue Point
Mark IN (a)

Mark IN (b)

Toggle the audio stereo 1 of the player

Toggle the audio stereo 1 of the player (secondary
shortcut)

Toggle the audio stereo 2 of the player

Toggle the audio stereo 2 of the player (secondary
shortcut)

Toggle the audio stereo 3 of the player

Toggle the audio stereo 3 of the player (secondary
shortcut)

Toggle the audio stereo 4 of the player

Toggle the audio stereo 4 of the player (secondary
shortcut)

Toggle player video

Toggle player video

Fast forward the media

Fast rewind the media

Jumps to end of clip or media
Goes to clip IN point

Goes to clip OUT point

Jumps to start of clip or media
Inserts a cue point

Sets clip IN point

Sets clip IN point (secondary shortcut)
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Player

Mark OUT (a)
Mark OUT (b)
Next Frame (a)
Next Frame (b)
Next Cue Point
Next x Frames (a)
Next x Frames (b)

Play/Stop

Play Clip
Play Clip Loop

Play Forward
@ Play Reverse
Play NearLive
Previous Frame (a)
Previous Frame (b)
Previous Cue Point
Previous x Frames (a)
Previous x Frames (b)
Forward 25%
Forward 33%
Forward 50%
Forward 100%
Forward 150%
Forward 200%
Forward 400%
Rewind 25%

Rewind 33%

Sets clip OUT point

Sets clip OUT point (secondary shortcut)

Jumps to next frame

Jumps to next frame (secondary shortcut)

Goes to next cue point

Jumps to next x (preset) frames

Jumps to next x (preset) frames (secondary shortcut)

Plays/Stops loaded media in Player window from current
position

Plays the clip from IN to OUT once

Plays the clip from IN to OUT in loop mode
Plays forward at various speeds

Plays reverse at various speeds

Plays near-live a recording media

Jumps to previous frame

Jumps to previous frame (secondary shortcut)
Goes to previous cue point

Jumps to previous x (preset) frames

Jumps to previous x (preset) frames (secondary shortcut)
Goes forward at 25% speed

Goes forward at 33% speed

Goes forward at 50% speed

Goes forward at 100% speed

Goes forward at 150% speed

Goes forward at 200% speed

Goes forward at 400% speed

Rewinds at 25% speed

Rewinds at 33% speed
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Player

Rewind 50%

Rewind 100%

Rewind 150%

Rewind 200%

Rewind 400%

Rewinds at 50% speed

Rewinds at 100% speed
Rewinds at 150% speed
Rewinds at 200% speed

Rewinds at 400% speed

Stop Stops the player

Storyboard

Delete Deletes the selected line(s)

Move Down Moves the selected line(s) down

Move End Moves the selected line(s) to the end of the list
Move Top Moves the selected line(s) to the top of the list
Move Up Moves the selected line(s) up
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9.4

9.4.1

9.4.2

KEYBOARD MACHINES

INTRODUCTION

The profiles that are created for keyboard assignments can be assigned to
workstations through their IP address by the Keyboard Machines tool.

When you click the Keyboard Machines button, the Softwares Keyboard Machines
window is displayed in the Work area. It is divided into three areas:

1. Application Selection area
2. Profile Selection Area

3. List of machines

ward profiles |

117011

POSSIBLE ACTIONS WITH CONTEXTUAL MENU

A contextual menu is available when an application is selected in the Application
Selection area and a keyboard profile is selected in the Profile Selection Area and
then you right-click in the Parameters area:

Menu Item Description

Add Allows to assign a keyboard profile to a workstation. You
will have to enter the IP address of the workstation and
press the Save button.

Delete Allows to un-assign the keyboard profile to the selected
workstation.

&2 Note
The CleanEdit application may have to be restarted to apply the changes
if it is currently running on the workstation.
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9.5 VIDEO FX

9.5.1 INTRODUCTION

The Video FX tool sets the name and default parameters for the transition, clip
and conversion effects.

When you click the Video FX button, the Video FX window is displayed in the
Work area.

Yideo Tran

Dip ta

grey.dll

9.5.2 EDITING DEFAULT PARAMETERS FOR EFFECTS

To modify the default parameters for transition, clip or conversion effects, double-
click it in the list, enter/select new values in the relevant fields, and click the OK
button.
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10. Tools

10.1 INTRODUCTION

From the Tools category, you can manage projects, clips, edits, playlists and
broadcasted items, and you can define classes.

Nine items are available in the Tools category. They are detailed in the table

below.

ke
L"d
Frogram C

(N

Frojects banager

L d

Clips Manager

s b anager

dL
==

Tag Manager

M aritaring

Item

Description

Program Class
Manager

Allows to define classes
to categorize the edits.

Projects Manager

Allows to manage the list
of projects.

Clips Manager

Allows to manage the list
of clips.

Edits Manager

Allows to manage the list
of edits.

Playlists Manager

Allows to manage the list
of playlists.

Broadcasted Items
Manager

Allows to manage the list
of items already
broadcasted.

Tag Manager

Allows to define templates
and pages for external CG
integration.

Script Manager

Allows to activate scripts
performing some  pre-
defined actions.

Monitoring

Gives an overview of the
database content and the
disks capacity.
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10.2 PROGRAM CLASS MANAGER

10.2.1 INTRODUCTION

This tool is used to define and manage the classes structure of the database. It
allows the classification of the edits and tells the system that the edit has been
made for a particular production.

When you click the Program Class Manager button, the Program Class Manager
window is displayed in the Work area.

- & News Report

Ak 12
& Last Edition
- Highll
& Short
Long

10.2.2 POSSIBLE ACTIONS WITH CONTEXTUAL MENUS

A contextual menu is available when no class is selected and you right-click in the
Program Class Manager window.

Menu Item Description

New Root Creates a new class of program.

A contextual menu is available when you select a class in the list and then right-

click:

Menu Item Description

New Root Creates a new class of program.

New Child Creates a new sub-class of program.

Rename Allows to rename the selected class or sub-class.

Modify Opens the Modify Class window allowing to update the
label or description of the selected class or sub-class.

Delete Deletes the selected class or sub-class.

Hidden State Hides/Unhides the selected class or sub-class so users

cannot/can use it.

114



Xedio Suite Version 4.1 - User Manual — Xedio Manager Issue 4.1.D
EVS Broadcast Equipment — December 2011

10.3

10.3.1

10.3.2

PROJECTS / CLIPS / EDITS / PLAYLISTS
MANAGER

INTRODUCTION

The Projects, Clips, Edits and Playlists Manager tools are designed to show an
overview of the database content. They make it possible to edit properties and
remove undesired items from the database. Edits may also be recovered after
deletion by a user.

When vyou click the Projects Manager, Clips Manager, Edits Manager or
Playlists Manager button, the corresponding Manager window is displayed in the
Work area.

Each of these manager tools has a similar interface with 2 areas.

The upper part of the Work area shows a list of icons. These buttons give access
to the different filters to be applied to the media list.

The element grid displays the content present in the database, or it returns the
result of a search applied to the list.. Items are displayed in columns.

ELEMENT GRID

DISPLAYED COLUMNS

It is possible to re-arrange the columns order, and to add or remove some
columns.

Right-clicking on any of the column headings displays a contextual menu. The
Choose Displayed Columns option opens the Select Visible Columns window
allowing you to choose the columns you want to be displayed in the element grid.

The column width and order can be adjusted using standard computer commands
and drag and drop techniques.

ELEMENT GRID CONTEXTUAL MENU

A contextual menu is available when you right-click on an item in the list. The
options may differ according to the tab selected.
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Projects Manager

[

red SearcH

fod n Date | VideoStandard | Hidden | Deleted User DB Id al Project DB Id |
5:54 | PAL 5D 7

2 Miss Suisse_ XDCA Project created by e24-03-2009 12:57:14 14.09-2009 13.57:14 HD 1080i @50 7
3 Concent__=DCAM  Project created by e24-03-2009 12:53:16 24-09-2009 12:5% 76 HD 1080i @50 7
4 Concert__*DCAM  Project created by e24-03-2003 14:00:11 *4-03-2003 14:00:11  HD 1080i @50 7
5 Athletisme__<DCAM Project created by e24-03-2003 14:03:38 4-03-2009 14:0338 PAL 5D 7
B Athletisme_ <XDCAR Project created by e24-03-2009 14:05:18 14.09-2009 140578 PAL SD 7
7 Athletisme 1-10-2003 14:18:04 N-10-200914:18:04  HD 1080i @30 n
B Project_001 J6-10-2009 11:13:39 £10-2009 11:40:46 PAL 5D 12

Project Menu Item Description

Hidden State Allows to change the “hide” status.

Deleted State Allows to change the “delete” status.

Delete Projects Allows the deletion of the selected projects. This will
automatically delete the edits and clips contained in the
project.

Properties Displays the Project Properties window and allows to

change the project properties.

Used by... Opens a window to show where the project is used.

Clips Manager

Label L5M ClipHame Creation Date Clip TC IN Clip TCOUT | T il In T il Out | LSM Quality LSM Camera LSM CamPref &3

8120 241200165913 23264400 23960013 | gbpintd D
o1 s zmEn Zmm2n o
. snomssma|  mseoms| st 0
Clip Menu Item Description
Properties Displays the Clip Properties window and allows to change

the clip properties.
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Description

Delete Clip(s) &
Purge

See section 10.3.4 ‘Delete & Purge’ on page 119.

Force Delete

Deletes a clip with all the references of its use in the
database. If it is used in an edit, this will cause “holes” in
the edit.

This option must be used very cautiously.

Create Missing
Thumbnails

Creates thumbnails IN and OUT. Thumbnails are
displayed provided that the Show Thumbnails box is
selected and that the Thumb IN and Thumb OUT columns
are made visible.

Used by...

Opens a window to show in which projects and edits the
selected clip is used in.

Edits Manager

[ orouig e
1M port 00:00:00:00
2 Mews Report, Last E 00:00:28:12
3 Mews Report 00:01:04:10
4 Mews Report 00:01:04:10
5 Mews Report 00:01:04:10
E Highlights, Short  00:00:26:02
7 Mews Report 00:0012:13
8 MNews Repart 0001213
9 Mews Repart 00:16:11:04

Edit Menu Item

&1 retiieved Search
Label | Desciplion ___Creaton Date fodification Date __ Aspect Ao tansission Date O Dote I8
Edit_o01 2 48 B3
Edit_001 1N-10-2009 14:22:17 13-10-2009 13:3717 16/3
Edit_001 16-10-2003 14:53:34 16-10-2009 15:51:10 443
Edit_001 Duplicatec 6-10-2009 14:43:17 2.01-201010:54:02 443
Edit_001 Duplicatec 6-10-2009 14:53:23 6-10-2009 14:53:23 443
Rugby_Edit_1 13-10-2009 13:44:39 '8-10-2009 11:11:05 16/3
Concert 1 18-10-2009 090818 18-10-2009 09:42:29 16/3
Concert 1 26102009 11:10:50 $8-10-2009 11:11:41 1649
Cancert 1 28-10-2009 11:12:02 *8-10-2009 12:43:25 1649
Description

Deleted State

Allows to change the “delete” status.

Delete Edit(s) &
Purge

See section 10.3.4 ‘Delete & Purge’ on page 119.

Force Delete

Deletes an edit with all the references of its use in the
database, as well as the media contained in the edit.

This option must be used very cautiously.

Export Edit(s)

Allows the edit to be exported
e into a folder or

e into another CleanEdit database. You will then have to
mention the Database Source Name.
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Edit Menu Item Description

Import Edit(s) Allows to import an edit: in the Import window, right-click
the Folder(s) field and select Add Folder(s).

Play Opens a player window in which the selected edit can be
viewed in low or high bitrate.

Show Used File(s) Shows the list of files used by the edit.

Convert Ratio Allows to change the video ratio.

Properties Displays the Edit Properties window and allows to change
the edit properties. If a default metadata profile has been
defined for edits, a metadata tab is displayed and allows
to modify the edit metadata values.

Duplicate Edit Creates an edit with the same properties. The term
‘duplicated’ is added next to the new edit.

Generate PLST File Generates a text file which represents the edit and which
can be dropped on the playout.

Used By... Opens a window to show in which projects and playlists
the selected edit is used in.

Playlists Manager

- H % 13 ratieved

Db 14 Label —— Cicoton Dt odcaton D NOS AU W15
3 124 2. 35

il 4.

4 Playlist! J6-10-2009 15:35:53 )6-10-2003 15:37:23 J6-10-2009 15:35:53 ¥
B Playlist! 30-10-2009 16:24:08 I0-10-2009 16:24:57 30-10-2009 16:24:08
7 Playlist! #5-11-2003 11:16:36 25-11-2009 11:16:38 5112009 11:16:36

10 Playlist_pge_001  26-11-2009 16:40:33 20-01-2010 12:02:29 16-11-2009 15:40:33

11 Playlist_pge_002  26-11-2009 16:40:58 11-12-2009 11:00:26 26-11-2009 16:40:58

12 Flaylist1 #7-11-2003 08:42:25 7-11-2003 14:45:14 7112009 08:42:25

Playlists Menu Item Description

Deleted State Allows to change the “delete” status.

Delete Playlist(s) Allows the selected playlist(s) to be deleted.

Show Used Files Shows the list of files used in the playlist.

Properties Displays the Playlist Properties window and allows to

change the playlist properties.
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10.3.3

10.3.4

10.4

Item Label

SEARCHING THE DATABASE

The Xedio Suite offers several ways to filter the database. They are described in
section 6.6.3 ‘Searching the Database’ on page 45.

Filters you have defined can be saved to be applied later on in one click. Saved
Filters options are described in that section as well.

DELETE & PURGE

The Delete Edit(s) & Purge and Delete Clip(s) & Purge functions allow the user
to remove unused edits and clips from the media server while deleting them from
the database.

There are several options available when using this function:
1. Delete Edit/Clip database references: removes entries from the database only.

2. Delete Edit/Clip database references AND media database references:
removes entries from the database only.

3. Delete Edit/Clip database references, media database references AND linked
media files from online/nearline storage: removes entries from the database
and from the media server.

The media will be removed only if they are not used in other edits or in other
playlists (either the media itself or through attached virtual media or virtual clips).

Additionally, all associated material such as virtual media and virtual clips that are
used in the edit(s) or playlist(s) selected for deletion will be removed from the
database.

For more powerful media delete and purge options, see sections 12 ‘Media File
Cleaner’ on page 127.

BROADCASTED ITEMS MANAGER

The Broadcasted Items Manager gives the list of all items played out from Playout
Organizer software. The tool is designed to have an overview of the database
content and remove items that are no longer required because they have been
flagged as broadcasted.

When you click the Broadcasted Items Manager button, the Broadcasted Items
Manager window is displayed in the Work area.

Edits " q it Mo - Riefresh [F5)

Media

Item Type  PlayList Label UserName Playout Server broadcated DateTimelete Program Class
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SCRIPT MANAGER

A series of scripts is available from Xedio Manager and can be activated from the
Script Manager.

When you click the Script Manager button, the Script Manager window is
displayed in the Work area.

Avvailable scripks Applied scripts

Edit_Lpd_RTE_ToxT

The table below gives a description of the scripts you could find in the list:

Script Description

CEDB_ArchiveOlderMedia Archives once a day all media older than x
hours

CEDB_PurgePartialMedia Purges partial media that have been created for

more than 24 hours and that are not scheduled
in the next 24 hours.

CEDB_RenderBroadcastedJob Allows the execution of a script for export and
rendering of each edit broadcasted since more
than 24 hours.

CEDB_RestoreToBePlayed Inserts a restore task in EvsTaskEngine do-list
for each edit to be played in the next Z hours.

Edit_Upd_RTB_ExportEdit Exports an edit to a playlist file and reference
it in an xml file.

Edit_Upd_RTB_ToDB Renders and publishes to DB when an edit's
R2B_DateTime is updated.

Edit_Upd_RTB_ToXT Renders and publishes to EVS video server
when an edit’'s R2B_DateTime is updated.
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10.6

To enable a script, select it in the Available scripts list and press the >> button to
move it in the Applied scripts list.

MONITORING

When you click the Monitoring button, the Monitoring window is displayed in the
Work area. It gives an overview of the database content and the disks capacity.

245 g5 | 57 g wedioad|
wirkualMedia_pge_ 0001
PHI

5 xedioad|

=t wedioad|

PlayLists
Scheduler

| acities

®STOREYOL10
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11. Users

INTRODUCTION

The users authorized to access the Xedio Suite are defined in Xedio Manager,
under the Users category.

Three items are available in the Users category. They are detailed in the table
below.

M anager

ufy

Origin b anager

~

Manager

ltem Description

Manager Manages the users and access rights.
Origin Manager Manages the user groups.

License Manager Allows software connection to database.
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11.2 USER MANAGER

11.2.1 INTRODUCTION

Login and access rights have to be defined and stored into the database before
being able to use any of the Xedio Suite software.

When you click the Users > Manager button, the Users Manager window is
displayed in the Work area.

Support

Suppor Login :

Usger Origin : ppoit

upport

Parameter profile
io b anager Adrnin <default pro
| CleanE dit Adrin <default pro
Adriin
Admin
Adriir
Adrnin
Admin
Adrnin
Adrnin
io Media Cleaner Adriin
AutoFile [mporter Admin
i Explarer Adriit
Adrnin
v Organizer Admin
i Cutter Admin
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11.2.2 CREATING A USER

11.2.3
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To create user, complete the following fields and then click on the Apply button.

The user name is added to the list on the left side of the window.

Field

Description

Check Locked

Enables to check active users, i.e. users associated to
existing media, projects, edits, clips or playlists.

Account Enabled

Allows to enable or disable the selected account.

First Name First Name of the new user.

Last Name Last Name of the new user.

Login Login, or user ID, of the new user.

Password Password attributed to the new user account.

User Origin See section 11.3 ‘Origin Manager’ on page 125.
Description Optional text to describe the user.

User Level Level of user rights defined for each application of the

Xedio Suite. Only three levels exist: No Access, User
and Admin. The Admin level gives access to the Xedio
Manager.

Parameter Profile

The parameters profiles can be set for each application in
the Software > Parameters Profiles category of Xedio
Manager.

When no parameter profile has been defined for an
application, the default profile is used.

POSSIBLE ACTIONS WITH CONTEXTUAL MENU

A contextual menu is available when you select a user in the list and then right-

click:
Menu Item Description
Delete Delete the user from the database.
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11.3

11.3.1

ORIGIN MANAGER

INTRODUCTION

This tool is used to define and manage the user origin, which provides a structure
for each user within the Xedio architecture. When a user account is created a user
origin value is entered for the user.

When you click the Origin Manager button, the Origin Manager window is
displayed in the Work area.

EVS Broadcast Equipment

11.3.2

CONTEXTUAL MENUS

A contextual menu is available when no label is selected in the list and then you
right-click:

Menu Item Description

New Root Creates a new origin.

A contextual menu is available when you select a label in the list and then right-
click:

Menu Item Description

New Root Creates a new origin.

New Child Creates a new sub-origin.

Rename Allows to rename the selected origin or sub-origin.

Modify Opens the Modify Class window allowing to update the
label or description of the selected origin or sub-origin.

Delete Deletes the selected origin or sub-origin.

Hidden State Hides/Unhides the selected origin or sub-origin so users

cannot/can use it.
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LICENSE MANAGER

Control Manager [P ;

Apply

The License Manager IP address is read by each workstation software when an
application starts. The applications connect to this address and ask for a new
available connection (license). If allowed, the application will launch, otherwise,
an error message will be displayed and the application will not open.
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12. Media File Cleaner

The Media File Cleaner is a tool that allows the user to retrieve and list the
orphan files. These are files that are stored on the media server but that are not
referenced in the Xedio database. These files can be viewed and deleted.

The Media File Cleaner is available from the Tools menu in Xedio Manager
providing that no tool is selected in the Outlook area.

SubFolder Filker

A filtering can be applied before starting a search for orphan files. This filtering
allows the user to perform the search on all the media servers or only on one of
them and in all the folders or in only one of them.

Once the filter is configured, the search is started using the Refresh button or the
F5 keyboard shortcut.

A right-click on an orphan media opens a contextual menu that allows to Play the
media or to Delete it.

Deleting a media file means removing it definitively from the server. This
operation cannot be undone. To prevent accidental deletion, the following
confirmation message is displayed before the operation is completed:
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